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Update History   Latest program is at: www.w5big.com/prog_update.htm 
 
July 9, 2015  Version AIM_910A: 
Introducing the AIM_4300. 
  
May 8, 2015  Version AIM_900: 
This fixes several inconsistencies that were in the AIM_885 version. 
 
Mar 30, 2015 Version AIM_885A: 
Fixed a problem in the custom cal routine. 
 

Mar 6, 2015 Version AIM_885: 
 
 Measure Min, Max, and Average of  scan data between two cursors.  
 Save Custom Cal Limits in the init file. 
 Increment csv file name automatically after pressing U hotkey.  Name=Date+time 
 Fixed command buttons so they are inside the main graph window. 
 Fixed freq data in CSV file so it's the same as the frequency in the *.scn file. 
Added labels to the band highlight areas.  e.g.  20M,  15M, etc 
Admittance scales can be displayed on the Smith chart. 
Point Data is plotted in real time on the Smith chart. 
Added a Zoom function that can expand the plot about a specified point.  
---------------------------------------------------------------------------------------- 
 
 Aug 18, 2014 Version AIM_880: 

 
 Overlay scan files with any scan limits. Plotting style can be specified. 
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(Scan files from earlier versions of the AIM program can be recalled and overlaid .) 

 

 Improved crystal measurements for high Q crystals. 
 
 New Cal file data format.  This allows for new features but new cal files are required for 

version 880 

 

June 2, 2014  Version AIM_876: 
 
Amplitude programming in the Constant Freq mode can be used with AIMuhf and 
AIM4170D. 
 
Added function to calculate length of phasing line. 
 
 Fixed BitMap function so it always shows the whole AIM graph. 
 
 Adjust graph size with mouse. 
 Graph size and also be entered manually in pixels or percent  

(width, height value <= 100 means this value is a percentage of full screen). 

 
 Stub tuning runs much faster now. 
 
 Programmable Trigger Output  (see Appendix 14). 
 
 Improved performance for low values of series resistance.  
 
 Optional cursor for a tablet pc makes it easier to move the vertical data cursor. (refer to 
the Setup menu) 
 
 Fixed graph overlay problem.  (second graph was not being displayed at all) 
--------------------------------------------------------------------------------- 
Sept 27 2012 
The stub tuning function has been generalized for any fraction of a wavelength 
--------------------------------------------------------------------------------- 
Aug 28 2012 
Major changes to the Point Data function to aid in production testing. 
--------------------------------------------------------------------------------- 
 

May 21 2012 
Changed the word Theta to Phase.  The calculations and the data are the same as before. 
Some of the pictures in the manual may show Theta but the meaning is identical: 
Phase=arctangent(Xs/Rs). 
 
SWR scale can be offset by one vertical division to improve readability in certain cases.   
Smith chart trace can be displayed in varying colors across the frequency scan range. 
--------------------------------------------------------------------------------- 
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Feb 2012 
Added DSP filters for all models of the AIM. 
 

Dec 19, 2011: version 852 
DLL functions have been implemented for controlling the AIM with a user written 
program. 
 
Data logging can be turned on and off while in the Point Data Tune mode. 
--------------------------------------------------------------------------------- 
 
Oct 10, 2011: version 846 

 
New Difference of Scans function. 
TDR range has been increased to 2000 feet. 
--------------------------------------------------------------------------------- 
 

Aug 2, 2011: version 845A 
Scanning rate can change dynamically for faster scanning of a large frequency range. 
--------------------------------------------------------------------------------- 
  
July 21, 2011:  version 845 
Plot inductance or capacitance vs. frequency. 
Optional labels for traces. 
TDR files can be viewed in demo mode. 
Sync output documentation added in Appendix 14. 
--------------------------------------------------------------------------------- 
  
April 30, 2011:  version 840 
Added TDR function. 
Both swr rulers are displayed on the Smith charts. 
--------------------------------------------------------------------------------- 
 
March 8, 2011:  version 835 
 
Display cursor data and the differences for two points.  
The recycle depth can be set using the Setup Menu.  
The crystal analysis function now goes down to 25KHz. 
 Information on the usb interface as been added to Appendix 4. 
 A data Smoothing function has been added to replace Trend.   
 An offset can be applied to the plotted parameters.  
 Two rulers can be displayed for plotted parameters.  

 Overlay the last two graphs by pressing CNTL+Up Arrow. 
 The present state of all functions can be saved in a user specified file.  
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Quick Start 
 
Loading the Software:    

 
The AIMuhf, AIM4300, AIM4170 and PowerAIM have the same basic features.  The 

primary difference is the maximum frequency.  The maximum frequency capability of the 

instrument is determined automatically when the program starts.  In this manual, 

references to the AIM also apply to the AIMuhf and PowerAIM. 

 
The AIM software does not require a formal installation procedure. It does not interfere 
with any other programs or the registry on your computer.  Several versions of the 
program can be resident at the same time. 
 

If you have been using an earlier version of the AIM program, make a note of the comm 
port number before loading the new version.  On the menu bar at the top of the screen, 
click Setup -> Enter comm port.  The present comm port number is the default value 
shown in the dialog box.  After loading the new version of the program, enter this same 
value in the dialog box,  then enter the config file name using the menu: Files -> Load 

config file and then close the AIM program.  It will be ready to run.  You do not have to 
reboot the computer.  

 
1) Create a folder or a subfolder on any convenient hard drive.  Any name can be used for 
the folder, for example:   “C:\AntennaAnalyzer”. 
 
2) Download the latest program: 
AIM Program Update. (http://www.w5big.com/prog_update.htm)  
This program works with the AIMuhf, the AIM4170 and the PowerAIM 120. 
 The AIM4300 requires the newer versions starting with AIM_910A. 
 
The only difference between the AIM4170C and the AIM4170D is the AIM4170D has 

a USB connector for direct connection to a USB port on the PC.  The AIMuhf and 

AIM4300 also have usb connectors. 
 
3) Unzip all the files in the folder you just created for the analyzer software and 
documentation. 
 
4) The file labeled “AIM_xxx.exe” is the executable file. It is ready to run without going 
through an installation process.   If you don't see the exe extension, your file display has 
the "don't show extensions" flag set.   This is the default setting for new Windows 
installations and the flag should be turned off.  The AIM program can still be used, but 
it's a lot easier to navigate through all your folders if this flag is turned off so you can see 
the extension of all the files.   
 



 Antenna Analyzer AIM                                                                                         page 7 

 - 7 - 

When later versions of the program are released, the number “_xxx” will be different. All 
versions of the analyzer program can reside in the same folder at the same time, although 
separate folders can be used to keep the files organized.    
 
The older programs with the lower numbers will not interfere with the newest version, so 
they do not have to be deleted.  If there is any question about the performance of a new 
version, you can switch back immediately to an earlier version for a comparison if they 
are in separate folders.    
 
If you want to make a shortcut icon for your desktop, right click on the AIM_xxx.exe file  
and select “create shortcut” from the dropdown menu. Drag the shortcut to your desktop 
or task bar.  Right click on the icon to bring up the renaming option and enter the file 
name. 
 
If the files are loaded from a CD, they may be flagged as “read-only”.   In order for the 
calibration and initialization data files to be updated properly, the “read-only” flag must 
be cleared.  Highlight all the files in the folder by pressing control-A and then right-click 
to see the properties of the files. If the “read-only” property box has a checkmark, 
uncheck it and then click “Apply”.  This will remove the read-only flag on all the 
highlighted files.   None of the files in the folder need to be read-only. 
 
For operating tips or to post your own ideas check this forum: 
http://www.w5big.com/forum.htm  
 
HARDWARE CONNECTIONS: 

 
Plug in the DC power supply (8 to 12V at 500 ma recommended) and insert the connector 
into the jack on the rear panel of the analyzer.  Note: if a power supply is included with 
your AIM, it is for 120VAC only.  [The Global Power Supply (120-240V) is available as 
an option when ordering the AIM.] 
 
Press the power switch. The Green LED will blink a few times to indicate the version of 
software and then remain on continuously. The Red LED is on only when a measurement 
is in progress. 
 
To turn off the power, press the power switch again.  The green LED will go off when 
you release the power switch.  If the analyzer does not receive a command from the PC 
for 10 minutes, it will power down automatically if it is in the default AutoPwrOff mode.  
The AutoPwrOff mode can be turned on/off with a menu selection under the Setup tab at 
the top of the screen.   
 

When using the AIM with a new antenna system, check the AC and DC 

voltage between the antenna ground and the ground used for the AIM 

and the PC. This voltage should be less than 1V.  A balanced antenna 
should have a DC connection to ground through a balun or RF choke on one 
side (or both sides).  Of course there should always be a large value resistor 
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(or balun) connecting both leads of any antenna to a ground path in order to 
drain off static electricity.  This protects the AIM and any capacitors that are 
used in the antenna tuner. 
 

NOTE:  Before connecting a transmission line to the input of the AIM, be 
sure to momentarily short its pins together to drain off any static charge that 
may be present.  Also, be sure there is no DC voltage on the antenna. If 
there is DC, use a blocking capacitor between the AIM and the antenna 
input. 
 
Antennas and transmission lines can have enough static charge to damage sensitive 

electronic equipment. This can happen even when there is no rainstorm in the area. 

A strong wind can generate static charge. So can just flexing a coaxial cable by 

rolling it up or unrolling it, even if there is no antenna connected to it.   
 
An antenna or a component to be measured should not be connected or  

disconnected from the analyzer while a test is in progress.  A test is in progress when 

the RED LED is on.    
 

Be sure the maximum input voltage at the DC power connector does not 

exceed 15 volts. The minimum input voltage required is 7.0 volts.  
 
NOTE:  Low cost power supplies that plug in the wall are usually not regulated and their 
maximum output when no load is connected may be several volts higher than their rated 
output. Use a scope to check the peak output voltage with no load to make sure it 

does not exceed 15 volts.   
 
Power supplies that operate on a wide input voltage range such as 120V to 220V use a 
switching regulator. Evaluate the AIM measurement results to see if noise from the 
power supply may be a problem.  For comparison, you can take some measurements 
while using a 9V or 12V battery and then with the AC power supply.   
 
The AIM can be operated on battery power for remote operation with a laptop or tablet 
computer.  The current required is about 250ma (400 ma for the AIMuhf) while a 
measurement is in progress and about 50ma when idle.   
 
Batteries are not included with the AIM but you can make a battery pack using any type 
of batteries you like.  There is room inside the case for a 9V battery and disconnect 
diodes are included so the battery and the AC power supply will not interfere with each 
other.  There is also a space for an optional resistor to use for trickle charging a battery, if 
desired.  Trickle charging generally should be limited to 5% of the maH rating of the 
battery.  Check the data sheet for your battery for details. The main power on/off switch 
controls the battery power too, so the leakage current is less than one microamp when the 
AIM is turned off.  Refer to Appendix 6 and the Application-Help file for more details 
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When using the AIM to test a mobile antenna on a motor vehicle, it is better to use a 
separate battery and not the 12V battery in the vehicle.  A 9V battery will power the unit 
for several hours or a small 12V gel cell (sealed lead acid) battery can be used for 
extended operating periods.  This avoids the problem of sneak paths through the ground 
between the DC power input and the antenna ground connection.  It will also help reduce 
measurement noise if it’s necessary to run the engine while taking data (such as to 
operate the air conditioner).  If it’s essential to get power for the AIM from the 

vehicle, be sure to put 500 ma fuses in BOTH the +12V lead and the power ground 
lead.  A small voltage drop across the fuses will not affect the AIM since the battery 
voltage is much more than the required minimum operating voltage.   The laptop 
computer being used should remain floating with its own battery for the best 
measurement accuracy. 
 

 

PC INTERFACE CABLE: 

 
Connect one end of the RS232 cable to the analyzer and the other end to COM1 on your 
PC.  If you want to use a different COMM port, start the AIM program and click on the 
Setup menu at the top of the screen. Then click on Enter Comm Port and enter the port 
number  that you want to use. This number will be saved in the setup file called 
AIM_xxx.ini.  
 
If you are connecting to the RS232 port with a USB adapter, (or directly to the USB port 
with an AIMuhf) you will need the appropriate driver.  The preferred USB adapters use a 
chip made by FTDI.  If the driver is not found automatically, you can get here: 
http://www.ftdichip.com/Drivers/VCP.htm 
 
If the computer is connected to the internet when the AIM if first connected to the 

comm port, the Windows 7 or 8 program may be able to find the driver 

automatically on the internet.  This may take two or three minutes.    
 
For more information on the USB interface, see Appendix 4 of this manual and this 
document:  http://www.w5big.com/PC_USB_INTERFACE.pdf 
 
To set the comm port, click on Setup -> Enter Comm Port.    
 
 The AIM program has been used with Windows versions 2000, XP, Vista, Win 7, Win 8 
and Win 8.1.  It also works with tablet computers that run Windows.  When using the 
touch screen, a mouse and keyboard are not required.  The program has also been used 
with MAC’s.  There is more information available here: www.w5big.com/FAQ.htm 
 
For more information on running the AIM with a tablet computer, refer to this document: 
http://w5big.com/aim_tablet.pdf 
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A custom configuration file can be loaded if desired:  
Click Files -> Load Config File and select the file called: _AIM_config.cfg that is in the 
same folder with the AIM exe file. 
 
 
 

Larger version of this image:    www.w5big.com/AIM_menu.png 
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Initial Operation: 

 
Launch the AIM_xxx.exe program.  You will see a graph similar to this: 
 

 

This is the last scan that was taken before the program was closed. Each time the 

program starts, it restores the previous scan. 

When the AIM is present,  it must be turned on before the PC program is launched.   
If the PC program starts when the AIM is not connected and powered up, the program 
will automatically enter the DEMO mode.   In demo mode you can view previously 
saved scan files.  This feature is handy for doing off-line analysis without having to hook 
up the hardware. 
 
 
 
                                      Scan using a 200 ohm resistor for a test load. 

 
The size of the graph can be specified in the Config File.  The ‘max graph width’ and 
‘max graph height’ parameters can be changed to make the graph compatible with 
smaller PC monitors.  Graph sizes down to 640x480 (and perhaps smaller) can be used. 
The ratio of the width to the height is not critical. When using a larger monitor, the graph 
size can be increased, if desired.    
 
There is an option to set the graph size by dragging the corner of the window with the 
mouse.  This option is enabled by clicking Setup -> Mouse_Resize.   When using a PC 
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with a touch screen, it may be necessary to leave the mouse resize option turned off to 
avoid a blinking display.   The window can also be resized manually by  
using the Setup menu to enter specific dimensions in pixels or as a percent of full screen.  
Click Setup -> Graph Size.  Several default sizes are already defined or you can enter a 
custom size.  To go back to the previous graph size, click Setup -> Graph Size -> 
Previous size. 
 
To save screen shots for a document or a web page, the size of the graph can be 
adjusted to optimize the screen to fit the finished document.   This eliminates the need to 
rescale the image using a paint program (like Photo Shop), which sometimes distorts the 
lines in a graph.  A special config file for this purpose can be saved and then easily 
recalled when it is needed.  The size of the present graph being used can be found by 
looking at the Status window.  Click Help -> Status.
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                                      Calibration 
 
Note: Beginning with program version AIM_880, the format of the cal data file is 

different.  If you have special cal files that were made with an earlier version, put them in 

a separate folder with their own program so they can be easily recalled.   

 
The AIM has no internal adjustments.  There are no trim pots or variable caps inside. 
All the calibration is done with the following software procedure.   
 
The new Standard Cal procedure calibrates at more frequency points over the whole 
range from 5KHz to the maximum frequency of the instrument.  This more thorough 
calibration eliminates the need for custom cal in some applications, such as broadcast 
band measurements.  (The previous Standard Cal procedure only calibrated from 1 MHz 

to the maximum frequency.) 

 
Click on the Calibrate menu and select Standard Cal. 
 

  
 
(The Custom Cal option is used for special applications and will be discussed later.) 

 
A message box will appear near the center of the screen, as shown below: 
 

 
 
Attach the connector with an internal short circuit (this is included with the AIM, it’s 
labeled “short” and the label is green). 
 
After the short circuit is in place, click Continue. 
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If the wrong load is attached, an alert is shown and you have the option to retry with the 
proper load or to stop the cal procedure.  If you want to use a non-standard cal load, you 
can click "continue".  This is only an alert, not an error message. 
 
The program will run for a few seconds to take several readings of the short circuit. A 
number in the upper left corner shows a count down value. 
 
Sometimes when calibrating with a coax stub or an external filter connected to the AIM 
RF port, the impedance may appear to be significantly different from a short circuit  and 
a message will appear asking if this is a valid condition. If the connections are correct and 
you really do want to continue with the special external hardware hooked up, click 
Continue.  Otherwise, click Cancel or Retry.  
 
After the short circuit has been calibrated, a new prompt appears: 
 

 
 
Replace the short circuit with an open connector (red label) and then click Continue.  
 
The program will run for a few seconds to take several readings of the open circuit. 
 
 For the best accuracy, especially at high frequencies, use an open connector of the same 
type that is used for the short circuit. This allows the program to compensate for the 
stray capacitance of the connector itself.  For example, 3 pF of stray capacitance due to a 
BNC connector represents a reactance of about 1K ohm at 50MHz which will appear to 
be in parallel with the load.  This will seriously affect readings at higher frequencies if it 
is not properly compensated. Therefore, the three calibration devices (open, short, 
resistor) should be carefully constructed so they have similar stray capacitance and 
inductance which will be cancelled out by the calibration procedure. 
 
NOTE: If you are using an adapter, leave it on the output connector of the AIM when 

calibrating the open circuit. In this way, the capacitance of the adapter itself will be 

included in the calibration process.   

 

For example, If you want to use a BNC-to-binding post adapter, calibrate the short circuit 
with a jumper wire across the binding posts. Then remove the wire and calibrate the 
open circuit condition with the adapter still attached. This procedure cancels the stray 
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capacitance of the adapter and you can get accurate readings of discrete components 
attached to the binding posts. The cal resistor can be a resistor with leads for this case. 
 
The calibration procedure can also cancel the effect of a short piece of coax that is used 
as a jumper to connect the AIM to the load. In this case, the open, short and standard 
resistor are connected to the far end of the jumper.  Good results have been obtained with 
as much as two feet (60 cm) of  jumper coax.  Longer coaxes can be calibrated with the 

Custom Cal procedure (discussed later). 

 
If the jumper is close to 1/4 of a wavelength long, the calibration data may not be 
accurate and a warning message is displayed. You can continue to cal but be sure to 
check the scan data for reasonable values under this condition.  If you’re sure the data is 
satisfactory, you can disable this warning message with a flag in the configuration file. 
 

 
 
After taking several readings of the open connector, the program will prompt for the 
standard resistor with a  typical value between 50 ohms and 500 ohms.   This resistor 
should be mounted on a connector like those used during the open and short calibration 
steps.  The exact value is not critical and it is not necessarily related to the reference 
impedance Zo.  For example, if you are measuring 75 ohm coax, you can still calibrate 
with a 50 ohm cal standard.  Enter the value that you measured with a digital ohmmeter 
and click Continue.  If you are using the cal resistor (yellow label) that is included with 
your AIM,  the number printed on it should be entered.  If you have a different cal 
standard, enter that value. 
 
After reading the standard resistor,  the Red LED goes off and the prompt for a comment 
appears. This optional comment will be saved with the cal file and can be read later in the 
Status window.  It can also be viewed in the cal file itself with any text editor (such as 
Notepad).  After entering the comment a request for the calibration data file name 
appears.  A separate folder can be used for cal files, if  desired. 
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Enter the name of the calibration file and click “Save”.  There is no restriction on the 
name of the cal data file. Its extension is automatically set to .acal (“analyzer cal”).   It is 
helpful (but not required) to include the program version name in the name of the cal file 
so you can tell at a glance which cal file can be used with a particular version of the AIM 
program.  If you have more than one AIM in your lab or work area, it is helpful to 
include the serial number with the cal file name too 
 
 Any of these cal files can be recalled later using the menu option File ���� Load Cal File. 
 
Then the cal complete message box is displayed as shown below:  

 
 
Click OK to continue. 
 
Each time the AIM program starts, the last calibration file that was used will be read to 
restore the cal data.  
 
Each AIM has an ID number associated with it. This ID number is attached to each 
calibration file so that cal files will not be used with the wrong AIM. This is important 
when several AIM’s may be in use in the same work area.  This ID number is placed in 
the cal file automatically and no additional user input is required.  The AIM’s ID number 
can be seen by clicking “Help” -> ”About”. If you don’t see the ID number, your AIM 
PC program is not the latest version but it will still work satisfactorily.   
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After calibrating, leave the calibration resistor attached to the RF connector and click 
the SCAN button in the lower left corner of the screen. 
 
The Red LED will come on while the scan is in progress. A blue bar will move across the 
top of the graph as the scan progresses. 
 
You will see a set of traces.  The actual values are not important, but this shows the AIM 
is functioning.   
 
This completes the calibration procedure. 

 
   

NOTE:  Before connecting a transmission line to the input of the AIM, be 
sure to momentarily short its pins together to drain off any static charge that 
may be present.  Also, be sure there is no DC voltage on the antenna. If there 
is DC, use a blocking capacitor between the AIM and the antenna input. 
 
Antennas and transmission lines can have enough static charge to damage sensitive 

electronic equipment. This can happen even when there is no rainstorm in the area. 

A strong wind can generate static charge. So can just flexing a coaxial cable by 

rolling it up or unrolling it, even if there is no antenna connected to it.   
 
An antenna or a component to be measured should not be connected or 

disconnected from the analyzer while a test is in progress.  A test is in progress when 

the RED LED is on.    
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Colors and Styles 

The color of each trace corresponds to the color of the label at the top of the Y-axis. 
SWR is RED and this scale is on the left side of the graph. On the right side the 
magnitude of the impedance is the inside scale and the trace is GREEN.  The reactance 
is in YELLOW, also on the inside scale. Reactance and impedance use the same scale. 
Reactance can be positive (inductive) or negative (capacitive). The phase angle of the 
load impedance is plotted in MAGENTA and this scale is on the outside of the right hand 
vertical axis.  These colors can be changed in the configuration (*.cfg) file if desired. 

The width of the traces can be specified in the config file. The default width is “2”. For 
some situations, such as presentation slides, a wider line may be desired. A separate 
config file can be set up so you can switch between display options quickly with the 
Files->Load config file menu. 

 
Each trace can be plotted in a different style to make it easier to visualize. This is 
particularly helpful when graphs are printed in black and white. The menu is shown 
below: 
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This example shows some of the styles: 
 

 
When a new style is selected, the graph is redrawn to show its effect. The styles are saved 
in the *.ini file.  The style only applies to the image on the screen, the raw data is not 
affected.  The traces for a “rescan” are plotted with plain lines. 
 
A legend showing the graph styles presently in effect can be displayed by clicking 
“Legend” on the Graph Styles sub-menu.  This will appear in the lower right corner of 
the graph.  The legend window can be repositioned so it doesn’t interfere with the plot.  
This is handy when using a screen shot ("Prt-Scr") for documentation. 
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Command Buttons 

The most common commands use the buttons along the bottom edge of the screen.      
Hot key equivalents are shown in parentheses: 

SCAN  (S)– Starts the frequency scan between the specified limits: Start_freq to the 
End_freq. (see Limits button below.)  Each time the scan button is clicked, the graph is 
cleared and the new scan data replaces the previous data in memory. 

RESCAN (R) – A new scan is started but the graph is not cleared. This makes it easy to 
see the before and after effects of changes to an antenna (or any discrete component 
being measured).  The new data replaces the previous data in memory but both graphs 
can be viewed simultaneously.  RESCAN can also be used to overlay new data on top of 
a scan that was loaded from a data file. See “File -> Load” below.  Rescan also works 
with the Band Scan function to repeat a band scan if the Scan button has not been 
clicked.    

RECYCLE – Scanning is repeated over and over until the RECYCLE or the HALT 
button is clicked.  This makes it possible to continuously view the results while adjusting 
an antenna or tuning a stub.  The resonant frequency is displayed above the graph and it’s 
updated after each scan during recycle.  The scan limits can be adjusted to narrow the 
scan range for a faster update rate.  Recycle also works with the Band Scan function to 
recycle a band scan if the Scan button has not been clicked.    

The number of scans between screen erasures is set using the Setup Menu item called 
Recycle Depth. If the depth is zero, the screen is never erased while recycling. If the 
depth is set to 5 (the default value), the screen will be erased after every five scans.   

POINT DATA (D) - Measure the impedance of a circuit at a specified frequency.  The 
measurement can be a single-shot reading or repeated about 2 or 3 times per second while 
the point data  window is open.  Click the “Tune” button to start the repetitive mode.   As 
its name implies, the Tune mode has been found to be very useful when adjusting an 
antenna tuner.  This avoids stressing the power amplifier when the antenna is mismatched 
and it eliminates interference to other people since the AIM output power is less than 20 
microwatts. 

You can switch between Tune mode and Single Shot mode any time by clicking the 
buttons in the Point Data window.  Click the Fast Rep button to increase the repetition 
rate.  The actual repetition rate can be customized by changing the Averaging value.  

While in Tune Mode a tone related to the SWR can be played through the PC speaker to 
assist in making adjustments without watching the monitor. Click the button labeled 
“Tone On” to start the tone. The parameters of the tone can be changed using the setup 
routine called “Tone” under the Setup tab on the main menu at the top of the screen.  
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SWR, Zmag and Phase can be sounded out in Morse code. See the Setup menu to enable 
this function.   The swr tone or Morse code can be played over an extension phone or cell 
phone while making adjustments to an antenna.  SWR can also be sounded out using 
speech wav files for the set of numbers. These files can be customized for other 

languages.  

If the Data Log button is highlighted, the Point Data is written to a data log file.  The 
log option can be turned on and off any number of times during one session. Only the 
data read while the data log button is highlighted will be saved.  In the Single Shot mode, 
one reading is taken each time the Single Shot button is clicked or each time the Space 
Bar is pressed. This makes it easy to data log a number of components at a particular 
frequency.  The frequency can be changed by clicking the frequency increment or 
decrement buttons.   

This file can be saved with a user specified name when the tuning session ends by 
clicking the Stop/Exit button.  The data file has the default extension *.AIMlog but it 
can have the extension  *.csv if you like.  The log file can be imported into a program 
like Excel for  customized processing. 

  

 
                                          Point Data Window for AIMuhf      

Measured impedance at the AIM RF port = Z = Rs + j*Xs 
Rp and  j*Xp correspond to the equivalent parallel circuit values. 

Zref is the reference impedance used to calculate SWR and the reflection coefficient, 
s11.  Zref is typically 50 ohms but it can be any desired value (including a complex value 
to account for loss in the cable).  For example, when testing a dipole antenna, the Zref 
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can be set to 75 ohms if desired.  It is entered using the Setup menu -> Enter Zref.    

The term Zref is used instead of Zo because Zref is not limited to being the characteristic 
impedance of the cable.    
 
This figure shows a length of RG59 terminated with 100 ohms and the value of Zref set 
to 75 ohms.  When Zref = 75 ohms the SWR line is essentially flat, as you would expect 
and the measured SWR is 100/75 = 1.3.   The AIM was originally calibrated with a 50 
ohm standard resistor.  You do not have to recalibrate when changing the value of Zref, 
that's taken care of automatically.   

 

The Fast Log mode gives a faster measurement rate while data logging, which may be 
useful when manually adjusting a circuit. 

                          
                                               Data Log File Example     

      

LIMITS (L)– When this button is clicked, a dialog box, as shown below, pops up for 
entering the start and stop frequencies and the size of the frequency increment (step) 
between measurement points. The start and stop frequencies range from 5 KHz to 
180MHz for the AIM and 5 KHz to 1GHz for the AIMuhf.   
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 For example, to scan the 40-meter band, you might enter 6.9MHz for the Start 
frequency, 7.4MHz for the Stop frequency and 0.01MHz for the frequency Step (the 
spacing between measured points). This would result in a scan of 50 points across the 
band.  The maximum number of scan points is 30,000 and the minimum number is 5.   

Frequency values can be in KHz instead of MHz if the number is followed by a K or k. 

There is an option to begin the plot along the X-axis at zero rather than at the Start Freq. 
This makes the plot easier to read in some cases. The scan will still begin at the specified 
Start Freq which cannot be less than the minimum frequency of the instrument.  For 
example, if you want to scan from 1MHz to 20MHz, the graph will be numbered starting 
a 1 and go up to 26.  This makes the numbers on the X-axis: 1,6,11,16,21,26.  However, 
if you start at 1MHz, stop at 20MHz and select the “start plot at zero” option, then the X-
axis will be labeled: 0, 5,10,15,20 and the actual scan will be from 1MHz to 20MHz. 

If you enter a number greater than 20 in the Step box, the scan will use that many data 

points.  (A step size equal to or greater than 20 is interpreted as a number of points 
rather than a frequency step in MHz.)   If the number in the Step box is followed by a 
percent sign “%”, the step size will be that percentage of the total scan width. 

Note that when using the cursor to read out numeric data (discussed in detail later), the 
displayed values are interpolated between the measured values. Therefore, in some cases 
it may be desirable to use a larger frequency step for a faster scan rate.  You can still 
read the parametric values at intermediate frequencies with the cursor.  The scan rate is 
about 20 to 70 points per second, depending on the speed of the PC and the value of 
averaging that is used.  

SCALES -  When this button is clicked, a dialog box pops up for entering the full-scale 
values for the traces.  
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 If the actual measured value is off the scale (flat line at the top of the graph), the value 
readout by the cursor is still valid since it uses the raw data stored in memory.  For 
example, you can set the Zmag scale to 500 ohms in order to see fine details but if the 
impedance actually goes up to 1600 ohms at some frequencies, the cursor can still read 
the true value and display it in the data window on the right side of the screen. 

There is an option to plot the SWR with swr=1 on the center line (y=0) or shifted up by 1 
division.  Clicking the Offset entry in the Setup menu will alternate between shift or no 
shift.  The offset does not affect the display when Log SWR is selected, in that case 
swr=1 is always on the y=0 axis.  

If you would like a full scale value that is not in the drop-down list for a parameter, you 
can manually enter any value in the box at the top of the list.  For example, if you want 
to evaluate a 50 ohm resistor, you can enter a full scale value of  60 in order to get better 
resolution on the graph. (this does not affect the accuracy of the raw data saved in 

memory).   

To get better resolution when the parameters don't change much over the frequency scan 
range, the High and Low limits for SWR, Zmag and Phase can be entered in the 
appropriate dialog box to expand these traces over a larger vertical range.  Two values are 
entered in the dialog box, separated by a slash character.  For example, entering  55/45 in 
the Zmag scale box will plot the Zmag between 55 and 45 ohms.  The Zmag values are 
shown on the vertical axis in green.  The lowest point at the bottom of the graph is 45 
ohms and the top point corresponds to 55 ohms.  Note that Phase scale values can be 
positive or negative. For example, Phase can be plotted between  45/-45 if desired or 
between -150/-180.  Phase values are always in degrees.   The High/Low limits can be 
used in any combination for these three parameters.   Each parameter is independent of 

the other two.    
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When you select a new scale factor, the last data scan will be replotted using that scale.  
The raw data for the scan is still saved with the full dynamic range so if you change the 
scale limits later, the original data can still be plotted with the new scales.  A new scan is 

not required.  The High/Low scale limits do not affect the scan data that is saved in a scn 
file, it will be the same regardless of the scales used for the display. 

COMMENT – A dialog box pops up for you to enter a comment that will be displayed at 
the bottom of the graph. This is very useful for documenting the test conditions. This 
comment will appear in a screen capture or a screen print and it will be saved in the raw 
data file on disk if this scan is saved.  Comments can also be added to a calibration file 
before it’s saved. 

HALT - While the scan is in progress, you can stop it by clicking this button. This is 
different from the QUIT button (shown below).  

QUIT – This stops the program, saves the setup conditions (limits, scales, etc) and exits 
back to the Windows OS.  When the program is launched again, the setup conditions and 
calibration data will be restored automatically.  
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                                    File Commands 

Load Graph--   Load a raw data file from a previous scan. After this file is loaded, its 
data is just like the original scan. The vertical cursor can be used to read out the numeric 
values.  

When a data file is being displayed, the name of the file appears at the top of the graph.   

After a graph is loaded, a new scan can be done and superimposed on top of the old data 
by clicking Rescan.  This is useful for comparing before and after conditions when 
adjustments are made or when there may be a  long term change in a component or an 
antenna. For example, you can see if your antenna is the same today as it was last week 
before the windstorm. 

When a new graph is loaded from disk with the same limits as the present graph, it can be 
overlaid over the existing graph or it can replace the graph.  Several graphs can be 
overlaid on each other. 

 

Save Graph --  Save the raw data for the last scan that was done. If you clicked the 
RESCAN button, the data that will be saved is for the rescan. Even though the earlier 
scan is being displayed on the graph, its raw data was replaced in memory by the new 
data corresponding to last rescan command.  The raw data is saved in a file with the 
extension .scn. Another file is created with the same name and the extension .csv. The 
.csv file has the same data in a format that can be read into a spreadsheet. The format of 
this file is shown in Appendix 5. 

You can enter an optional comment when the graph is saved. 

 

Overlay Graph - Load multiple graphs with any frequency limits.  The data will be 
plotted on the present graph even if the start/stop frequency limits and scale factors are 
different.  The style (circles, squares, etc) of the overlay graph can be specified to make it 
easier to distinguish the different graphs. Up to eight graphs can be overlaid at the same 
time.  Scan files that were saved with earlier versions of the AIM program can still be 
reloaded and overlaid. 

 

Swap Graphs -- Swap back and forth between the present scan and the previous scan.  
This function can be disabled by setting the “autoscansave” flag in the config file to zero 
(default is enabled). 

Swap can also be done by pressing either the up or the down arrow key. (Press the 
CONTROL key and then the arrow key to Overlay the graphs.) 
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Save Image Bitmap --  Save the current graph image to a file in the .bmp format.  If you 
just want to put the image on the clipboard to paste it into a document or another 
program,  press Alt-PrintScreen instead using of this menu function. Then paste it into 
another application using Control-V.  The bitmap image can be pasted into a paint 
program or a document, like Microsoft Word. 

 

Print -- Print the graph on the system printer.  Before printing in black and white, you 
can change the graph display styles to highlight each trace.  This option is under the 
Setup menu. 

 

Load Calibration -- Load a calibration data file for a particular test setup or adapter. 
These files have the .acal extension. 

 

Load Config -- Any of several configuration files can be loaded. A selection window 
will show all the files in this folder with the .cfg extension.  For example, this can be used 
to change the screen size or the colors for different applications.  After loading a new 
config file, close the program and restart it for the changes to take effect. 

 

Save State -- The present state of the programmable functions can be saved in a file 
named by the user.  This is the same data that is normally saved in the *.ini file when 
exiting from the program. It allows the user to quickly recall a new set of limits and scale 
factors for specific applications.  The state file can also be send to someone else so they 
can duplicate the test conditions.   

These files have the extension *.stat 

 

Load State -- Load a new state file. Restore the scan limits and scale factors. 

 

DC Power Off -- Remotely turn off the DC power to the AIM. (It cannot be turned on 

remotely) 

 

Quit -- Stop the program and exit.  
This is the same as the QUIT button at the bottom of the screen.
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                                               Function Commands 

Distance to Fault --Measure the distance to a cable open or short. This can also be used 
to measure the ¼ wave length frequency of  tuning stubs. The impedance of the cable is 
also measured.   

For accurate results, it is important that the cable be uniform, that is, it should not be 
made up of more than one type of cable. 

 

Refer to Antenna -- The impedance readings are transformed to be equivalent to 
readings directly at the antenna terminals.  This procedure does not require disconnecting 
the transmission line from the antenna if you know the parameters of the coax.   A 
weakness of this function is that parameters of coax are not constant over a long length 
and they may differ substantially from the published values in the catalog.    

This should not be used if the transmission line is made up of several different kinds of 

line, such as, coax cable plus ladder line. 

The Refer to Antenna function should only be used if Custom Calibration of the 
transmission line is not a viable alternative.  For complex transmission lines, the Custom 

Cal procedure must be used.   It’s discussed later in this manual. 

 

Constant Freq --  Output a constant frequency that can be used as a test signal. 
Initial frequency accuracy is +/-2ppm for the AIMuhf and  +/-30ppm for the AIM4170.  
At 1MHz, the output amplitude into 50 ohms is about 25 to 30mV-rms (-18 dBm) and 
somewhat less at higher frequencies.  The exact frequency can be calibrated using WWV 
or a frequency counter.  The default cal frequency is 10 MHz, but any value can be 
entered.  The initial setting has to be within 2 KHz of the standard used for calibration. 

The Frequency Compensation Factor that is used to correct all subsequent programmed 
values can be seen in the Status Window (Help->Status).  The value is always very close 
to unity.   The compensation factor is used to adjust the programmed frequency during a 
Scan or in the Point Data mode. 
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Band Scan -- Scan a band (particularly the AM broadcast band) to look for strong signals 
that may interfere with antenna measurements. The scan start/stop limits are set using the 
same LIMITS button that is used for an impedance scan.  The maximum scan range is 
10MHz. The maximum frequency step is 2KHz, but a smaller step can be specified 
when the limits are set. The recommended maximum amplitude limit for an external 
signal is indicated by a red line, which corresponds to approximately 150mv peak. (This 
level is not precisely calibrated.) Signals above this limit may result in less accurate 
impedance readings. It is not a rigidly fixed limit and in some cases, impedance readings 
may still be sufficiently accurate when external signals are above the red line.   

Click the Rescan button to repeat the band scan. 

 
                               Example of a scan in the AM broadcast band 

 

Measure Crystal -- Measure the parameters of a quartz crystal automatically.     
 Details are in a later section.  The crystal data can be saved in a file that can be imported 
to a spreadsheet program, such as Excel.  

The AIMuhf has a temperature compensated oscillator (TCXO) which makes it much 
more accurate than the AIM4170 when measuring crystals.  At room temperature, the 
drift over several hours is typically less than 1 Hz for the AIMuhf.  The oscillator can be 
calibrated in the Constant Freq mode by using a frequency counter or zero beating with 
WWV. This calibration will then be applied to all measurements.    The AIM4170C and 



 Antenna Analyzer AIM                                                                                         page 30 

 - 30 - 

AIM4170D can be retrofitted with a TCXO without too much trouble.  This is described 
in a separate application note called the AIM4170_Options_Guide.pdf.  

 

Stub Tuning  -- Adjust a coax line to be a specified fraction of a wavelength at a given 
frequency. The target frequency and the initial length (in feet or meters) of the coax are 
entered in the dialog box.   The unit of measure used for the cable length is given in the 
config file.  This parameter can be overridden by entering a value for the cable length 
followed by the letter "f" or "F" for feet and "m" or "M" for meters.   This value for 
physical length should be accurate because it is used to calculate the velocity factor. The 
wavelength can be entered as a decimal fraction or as degrees.  If the number is larger 
than 10, it is assumed to be degrees and it's divided by 360.  For example, entering "120" 
means the target wavelength is 0.333 (i.e. 120 degrees = one-third of a full wave) at the 
target frequency.   

 

  

 

The program runs in recycle mode and displays the amount of cable that needs to be cut 
off ("Excess Length") to obtain the target wavelength at the target frequency. A vertical 
red line on the graph highlights the target frequency. The magenta colored phase plot 
crosses the horizontal axis at the quarter wave frequency.  As the cable is trimmed, the 
present wavelength at the target frequency is displayed at the top of the graph along with 
the amount of cable that needs to be trimmed off.   
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Data at the bottom of the graph shows the cable impedance and the velocity factor along 
with the target values for frequency, wavelength and cable length.  The Recycle Depth 
indicates how often the graph will be erased while in the Recycle mode.  Zero means 
don't erase at all.  Five means erase and start over every five scans. The Recycle Depth 
value is entered with the Setup menu,  click:  Setup -> Recycle Depth 

 

Q Measurement – This is used to measure the Q of  resonant circuits.  First, do a scan 
with the limits set to include the resonant frequency and most of the response on either 
side of the resonant frequency. The step size is not critical but Q may change slightly 
with different step sizes. Experiment to see what is appropriate for your application. The 
resonant frequency does not have to be in the center of the graph.  

 

Antenna Bandwidth-- The bandwidth of an antenna at an SWR value set by the SWR 
ruler is determined.  First, enter the SWR ruler 1 value with the Setup Menu. Then 
position the cursor near the valley of the SWR curve and click “Antenna Bandwidth”. 
The bandwidth and high/low frequencies will be displayed in a message box.  Vertical 
green lines will highlight the bandwidth region.  For a multiband antenna, the bandwidth 
at each resonant frequency can be read by moving the cursor to the desired SWR valley. 
The cursor does not have to be exactly at the minimum SWR point.   
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After positioning the cursor near the desired point, press the left mouse button to freeze 
the AIM cursor while moving to the bandwidth selection button on the Function menu. 

 

Line Extension--  see the Line Extension section of this manual. 

Measure Zo - Measure the impedance of an open or shorted coaxial line. 

 

Difference of  scans - see details later in this manual. 

 

Trigger output - see details in Appendix 14 
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                                         Calibration Commands 

Standard Cal -- Calibrate the AIM using open circuit, short circuit and resistive load 
conditions. The calibration data is saved in a disk file that’s read each time the program is 
started.   The frequencies used for calibration are predefined in the program so the user 
does not have to enter these parameters. 

Any number of calibration files can be saved for different applications. 

An optional comment can saved with each cal file. The comment for the cal file presently 
in use can be seen in the Help->Status window. 

 

 Custom Cal --  The start, stop and delta frequency values can be user specified.  The 
regular short, open & resistor loads are used. Long transmissions lines of any type can 
be calibrated at the far end so impedance data is then referred  to the antenna terminals. It 
can also be used to calibrate out the effects of filters in the line.  This function takes into 
account the length of the cable, its impedance and the loss.  

After a transmission line or filter is calibrated, the start, stop and step frequencies can be 
changed as long as they are within the original custom cal start and end limits.  The step 
size can be different too. 

For the AIMuhf model, the menu shows several optional calibration ranges for quick 
reference. The values shown in the dialog box can be changed to anything you like.
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                                        Setup Commands  

Plot Parameters -- Select the parameters that are plotted during a scan. The optional 
parameters are: SWR or reflection coefficient or Q, L or C, Return Loss, Impedance 
Magnitude, Series Load Circuit or Parallel Load Circuit, Phase (phase angle).  The last 
scan data will be replotted with the new parameters. 

 

Graph Styles -- A different style for plotting each trace can be specified to make the 
traces more distinctive.  This is especially helpful when the graph will be printed in black 
and white.  For examples of the styles, refer to the section of the manual above called 
“Colors and Styles”. 

A style legend can be displayed in the lower right corner of the window.  This window 
can be repositioned if desired. 

 

Plot Offset Values -- The traces can be offset by a specified amount to make it easier to 
see small variations around an average value. 

For more information see the Rulers and Offsets Section 

 

Ruler 1 and 2 -- Horizontal rulers can be defined to help visualize where a parameter lies 
with respect to  user specified limits.   Two rulers can be defined for: SWR, Phase, Zmag, 
Rseries, Xseries, and Return Loss. These are referred to as Ruler 1 and Ruler 2.   Ruler 1 
is used when measuring antenna bandwidth.  Either ruler can have the larger value.   

   For more information see the  Rulers and Offsets Section 

 

Label Traces--  A letter can be displayed at the beginning of each trace to help 
distinguish it.  This is very useful for documentation if the graphs are printed in black and 
white.

 

Enter Zo -- Enter the nominal impedance of the transmission line. This is used  to 
calculate the SWR.  This is usually a real number, but a complex number can be entered 
with the imaginary part denoted by “i” or “j”. 

 



 Antenna Analyzer AIM                                                                                         page 35 

 - 35 - 

 

Average Readings-- Measurement noise can be reduced by averaging several readings at 
each point. When this option is selected, “AVG =N” appears in red in the upper right 
corner of the graph.  N is the number of readings being averaged and is between 4 and  
256.  N equal zero or 1 is equivalent to No Averaging. 

 

Smoothing -- Noise can be reduced by averaging (smoothing) a number of data values 
over a narrow frequency range.  The smoothing process does not shift the frequency of a 
peak or phase zero crossing.   This is most helpful in the VHF/UHF frequency range. 

 The magnitude of the peak or valley of a rapidly changing parameter may be affected.   
Check the results with and without smoothing if there is any doubt. 

 

 

 

 

Auto smoothing uses an averaging size corresponding to 2% of the number of scan 
points.  This value is recalculated automatically when the scan parameters are changed. 

Manual smoothing allows the averaging size to be specified by the user. This is always 
an odd number.  The largest value of smoothing is approximately 2% of the number of 
scan points.  A value of 0 turns smoothing off. 

Smoothing can be enabled or disabled without changing the value of the manual 
smoothing parameter. 

 

Recycle Depth -- In the Recycle mode, this is the number of scans made before the 
screen is cleared and it starts over. If the value is zero, the screen will not be cleared and 
the scans accumulate indefinitely. 

 

Enter Comm Port -- The value of the comm port is entered. This can be determined by 
using the Windows Device Manager. There is more information in the section about 
setting up the USB interface.  Some earlier versions of the AIM program had a Find 
Comm Port function, but that was always reliable, so it is not included here.  There are 
details about finding the comm port using the Windows Device Manager in the app note 
called: AIM_Tablet.pdf 
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Cursor Normally ON --  If this item has a check mark beside it, the cursor will move 
with the mouse and it stops when the left mouse button is pressed.  If  this item is not 
checked, the cursor only moves when the left button is pressed. 

 

Grid Highlight -- Some grid lines can be highlighted to make the display easier to read. 
The appearance of this effect depends on the monitor and it may not be desirable in all 
cases. 

 

Audio Out -- Options to output the parametric data through the audio channel in the 
Point Data mode. This can make it easier to perform adjustments without having to watch 
the monitor. 

 

Power Control ->Auto Power Down -- When using battery power, the AIM can be      
turned off automatically after about ten minutes of inactivity to conserve power. 

                           -> Low Current mode - reduce the average DC current while on battery    
                                                                    operation.    

 

Scan Mode -- 

Standard mode - This is the commonly used mode. 

Fast mode - Fast mode is about 3x faster than the standard mode.  It can be used when 
the phase doesn't change too abruptly during the scan.  The faster scan rate is handy when 
making adjustments to circuits or antennas in real time.  For a final check, change back to 
the standard scan mode to make sure no aberrations were introduced by the fast scan 
process. 

Dynamic Scan Rate -- The scan rate can be changed progressively during a scan to 
speed up the process. This is useful when scanning from a low frequency to a much 
higher frequency.  It is similar to a logarithmic scan (the horizontal scale is still linear).     

The frequency steps get larger from left to right, so the trace may not be as smooth but it 
is good for getting a quick overview while making adjustments. 
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                                                BAND Functions 

Highlight -- Highlight the frequency bands, such as the ham bands or AM or FM radio 
bands. These frequencies are specified in the configuration file (*.cfg). The start/stop 
limits do not have to be the actual amateur band limits.  The highlight color can also be 
specified in the config file.  

The name of the band can also be user specified to be more descriptive. Refer to 
comments in the config file.  The AM radio config file has examples showing the names 
of several station.  

 

Band Skip -- Scan only in the specified bands that are included in the present start/stop 
scan range and skip between bands. This makes it possible to scan several bands for a 
multiband antenna much more rapidly. 

 

Click on the desired band to set the start/stop scan limits and the frequency step between 
measurement points.  These limits can be changed in the configuration file. 

 Note these bands do not have to be amateur radio bands, they can be anything. 

The title of the band can be changed in the config file. For example, bands can be 
assigned for specific radio stations and their call letters can be used for the title. 

Band A..D are additional user specified band limits. Same as above.  
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                                             Marker Commands 
 
Markers can be defined to aid in collecting data at specific frequencies. Position the 
mouse near the desired point and right click. The marker frequency at the mouse appears 
in a dialog box. This value can be changed with a keyboard input.  The marker index 
number is assigned automatically. The markers are always sorted by increasing 
frequency. A number followed by k or K is considered to be in kilohertz, otherwise, it is 
in megahertz. 
 

 
 
 
Click the Insert button to add a new marker or the Remove button to remove a marker. 
When removing a marker, the one closest to the mouse position will be removed. The 
mouse does not have to be positioned exactly on the marker. 
 
As markers are entered, they are displayed as red dotted lines, as shown below. 
The marker display can be turned on or off with the marker toggle function (see below). 
After a marker is inserted or removed, the set of markers will be resorted in the order of 
ascending frequency. Up to 20 markers can be entered at one time. Sets of markers can be 
saved in files and recalled later.    
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Markers are controlled using the menu items under the Marker tab: 
Several options for the markers are shown in the submenu below: 
 

 
 
 
Display Marker Data – open a window to display all the presently defined markers and 
the data at these frequencies. The data is read once when the window is opened. Click 
Refresh to take another set of readings. Click Recycle to read the raw data at the marker 
frequencies repetitively. In the Recycle mode, the horizontal gauge in red shows the 
SWR graphically on a log scale from 1 to 5. This corresponds to the actual numeric value 
of SWR displayed in the third column.  This feature is very useful when adjusting 
multiband antennas since the SWR in each band is displayed in real time while 
adjustments are made.  Several markers can be defined for each band to get an idea of the 
bandwidth.   The following image shows marker data for a two-band trap dipole with five 
markers per band.  Note how the red gauge dips to a minimum at the resonant point of 
both bands (14.34 and 21.36 MHz).  These points are indicated by the green arrows. 
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The numbers in parentheses in the first column are the marker index numbers. The 
markers frequencies do not have to be equally spaced. 
 
If the graph presently displayed is from a scan that has been saved, the marker data will 
be taken from that data in memory and no new data is read from the hardware.  In this 
case, if some of the markers are outside the scan limits, a reminder will pop up indicating 
that data for some of the markers cannot be read.  Also, the refresh and recycle buttons 
will be grayed out. 
  
Phase Rotation – The marker data can be transformed to correspond to data that would 
be measured at the end of a transmission line with a specified electrical length or a 
network with a specified phase shift. 
 
Toggle Markers -  turn the marker display on/off without changing the markers in 
memory. 
 
Clear all Markers – removes all markers from memory. 
 
Save Markers – saves this set of markers to a user specified file. Any number of marker 
files can be saved.  These files have the extension *.mrk. 

 
When the marker data is saved using the SAVE button on the marker data window, a 
second file is also saved in a comma-separated-variables format (csv). This file as the 
same user specified name and the extension *.mrx. It can be input to a spreadsheet, such 
as, Excel.   
 
When the AIM program is closed, the present set of markers is saved in the *.ini file.  
 
Recall Markers -  recall a set of markers from a file. 
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Rotate Smith Chart – A second Smith chart can be displayed. There is an option to 
rotate its data by a angle corresponding to electrical distance along a transmission line or 
phase shift in a network.  The actual geometric rotation of the plot on the chart will be 
twice the value of the angle that is entered. 
 
Polar Plot –  In addition to the Smith chart, several parameters can be plotted in polar 

format. The parameters are: SWR, Z and s11.   
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                                                Utilities                                                 

L-C Matching Networks by WY2U 

This program which is available on the web takes the impedance data (R and X) that is 
measured at the input end of the transmission line and calculates the L-C network 
required to transform it to the correct impedance (for example, 50 ohms) to match the 
transmitter. This can be used when designing a tuner to find the components to match an 
antenna over the desired frequency range. 

When you click on this link, your computer must be connected to the internet. You may 
have to authorize the connection if you have a firewall program. 

 

ZPlots by AC6LA 

This program uses the data saved in the .csv file (by "File Save") to plot graphs for 
presentations. It features plot parameter selection and zoom capability.  It can plot 
parameters that were not included in the original AIM plot and the plot range can be a 
subrange of the original data. 

When you click on this link, your computer must be connected to the internet. You may 
have to authorize the connection if you have a firewall program.  You can download the 
Zplots program to your computer and then run it off-line.  

 

Twelfth Wave Matching - an interesting way to join two coaxes that have different 
impedances without using a matching section with a special (non-standard) impedance 
value.  This technique only requires two short pieces of the same cables that are being 
joined together. 
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                                      HELP Commands 

AIM Manual -- This manual can be displayed as a pdf file. 

 

Applications --  Information about particular applications with the AIM. This is in html 
format and can be edited by the user if desired. The file name is “applications_xx.htm”. 

 

Edit Config File -- The config file is opened in a text editor for making changes to 
parameters. After saving the file, be sure to close the AIM program and restart it to load 
the new config file.  

 

Status --  The status window shows the value of some variables and the current path 
names for files.  When Custom Cal is being used, the start, stop, & step parameters are 
displayed. 

 

Check Program Update -- Click this link when connected to the internet to go directly 
to the program update page at w5big.com.  

 

About -- The present version of the programs in the PC and the controller are displayed.  
The url of the W5BIG website is also displayed.
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                            Cursor  Data Display 

After a scan (or after loading a file from disk), the mouse can move a vertical cursor 
along the frequency axis and the numeric data for several parameters will be displayed 
continuously in a data window on the right side of the screen.   An example is shown 
below: 

 

The light cyan vertical line is the cursor. It moves with the mouse whenever the mouse 
pointer is inside the graph area. In this example, the frequency is 7.4477 MHz. The 
frequency changes in 1-pixel increments due to the mouse resolution, so some specific 
frequencies may not be displayable.  The data is interpolated between the actual data 
points that were recorded during the scan. The cursor can also be moved in small 
increments using the Left/Right Arrow Keys on the keyboard.  

 Normally the cursor moves whenever the mouse pointer is inside the graph area.  The 
cursor movement can be stopped by pressing the left mouse button. This makes it easier 
to select items on the menu without disturbing the data being displayed on the right side 
of the graph.  The action of enabling/disabling the cursor with the left mouse button can 
be reversed with an option on the Setup Menu.  Click: Setup->Cursor Normally ON 

Data in the window shows the characteristic impedance, Zo, has been specified to be 50 
ohms for this example. The SWR at 7.4477 MHz is 21.532, Zmag=35.239 ohms, and 
Phase= -84.352 degrees.  
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Parameter values for both a series and a parallel equivalent circuit are shown as Rs, Ls 
(series circuit) and Rp, Lp (parallel circuit).  Note that when the Phase angle is negative, 
the equivalent components, Ls and Lp, change to Cs and Cp automatically.  

At the top of the graph in the main window,  resonant frequencies of the antenna are 
displayed. These are the frequencies where the phase angle passes through zero.   

The names of the calibration and configuration files being used are shown in the lower 
right corner of the data window. The color used to display these file names can be 
selected in the configuration file. 
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                   Cursor Data Min/Max/Difference                  

The data at two frequencies can be displayed along with their differences by pressing  
numeric key 1 for the first point, moving the cursor to the second frequency and then 
pressing 2 for the second point.  This action can be repeated by moving to other points 
and pressing 1 or 2.  When using the numeric keypad, be sure the NumLock light in the 

upper right corner of the keyboard is ON.  Data in the small window will be updated each 
time a 1 or 2 key is pressed.  The two selected frequencies are indicated by vertical blue 
lines on the graph labeled F1 and F2.  The range between F1 and F2 is scanned to find the 
Minimum and Maximum values for each parameter and to calculate the Average of the 
data values.  These data are displayed in the window labeled Cursor Data along with the 
Deltas.   After a scan or rescan, the cursor data window is automatically updated. 

Close the Cursor Data Window by clicking the x in its upper right corner. 
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                                          Custom Calibration 

 

 

 

 

This specialized calibration procedure is useful for situations involving filters or long 
cables.  For most routine work with physically small sockets, adapters, or short cables, 
the Standard Calibration procedure can be used.  

This calibration technique allows the measurement reference point to be moved from the 
RF connector on the front panel to the end of a transmission line and/or a filter.  This 
cancels the effect of complex transmission lines and filters so the data at the antenna feed 
point can be determined more accurately.  The custom cal routine can be used to calibrate 
long transmission lines or a relatively short line that may be used for an interconnection 
in a lab setup.  This calibration process may take longer when a small delta-freq is used, 
but the actual scan rate is essentially the same using either standard or custom cal data. 

The user specifies the start, stop and delta frequency values for the calibration. 
Typically the delta frequency will be 1MHz or less to take advantage of the improved 
accuracy when a complex circuit is connected between the RF connector and the 
measurement point.   

The custom calibration procedure for the AIMuhf can be faster than the standard cal by 
specifying only the frequency range of interest rather than calibrating over the entire 
operating range of the instrument. 
 
The AIMuhf has some predefined cal limits that will be automatically entered into the 
custom cal dialog.  These values can be modified for specific applications.  

The same short, open and resistor loads are used.  The resistor value is not critical as 
long as it is accurately known.  When adapters are used, be sure to be consistent so that 
all three loads have the same capacitance and inductance.  For the open cal load, be sure 
to use an actual open connector. If the open cal load is not attached to the test connector, 
the stray capacity will not be properly calibrated.   This can represent an error of  several 
picofarads. 

Click Calibrate -> Custom Cal and the parameter entry dialog box will open. 

By default, data entries are in MHz but if a number is followed by a K or k then the 
number will be interpreted as KHz. 
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For the AIMuhf there are several predefined calibration bands shown on the menu. These 
ranges are used for the Custom Cal and the values can be changed to anything desired.  
The menu value are just a shortcut for filling in the dialog box before doing a custom cal.  
The three values on each line are the Start - Stop and (Delta Freq) values,  all in MHz. 

 

After the start, stop and delta limits are entered, there will be prompts to attach the short, 
open and resistor loads.  After the calibration is complete, there is a prompt for an 
optional comment to be included with the cal data file. Then the name of the data file is 
entered. The name can be anything, but you may want to make the custom cal files 
distinctive from the standard cal files so it’s easy to tell them apart.  After calibration, a 
scan is done automatically (without plotting the data) to see if the custom cal data is 
likely to be accurate enough for this particular setup.  When the external circuit has rapid 
changes in phase (such as a filter), the custom delta freq has to be small enough to 
include data during the phase transitions. In extreme cases it may be necessary to use a 
delta as small as 1 KHz. Up to 30,000 cal points can be used. 

If  a warning message is displayed, the cal data may still be ok in the frequency range of 
interest.  The overall results should be evaluated with known loads, such as resistors with 
good RF characteristics. 

The scan start/stop and delta limits can be changed without having to do the custom 
cal again.   Any start and stop values can be used as long as they are within the original 
custom cal start/stop limits. 

The comment that is included in the current cal file can be viewed by clicking Help -> 

Status.  The status window also shows the start, stop and delta parameters used for this 
custom cal file.  If a custom cal file is not being used, these data do not appear in the 

status window. 
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Custom Cal Examples: 

The effectiveness of the custom cal procedure can be seen in the following examples. For 
this series of tests, a transmission line made up of two different kinds of coax was used: 

 
The high pass filter cuts off below 1.8MHz. It’s a Broadcast Band High Pass Filter 
from Array Solutions. (see their website for more information). This is very useful for 
rejecting local broadcast stations while tuning a 160 meter antenna. Inserting this filter 
will normally preserve the SWR readings around 160 meters but the impedance and 
phase angle may be changed. By calibrating at the far end of the transmission line,  the 
AIM can then transform the antenna data and significantly reduce the distortion caused 
by the filter as well as the effect of two different types of transmission line. 

 

The figure above shows a scan using the standard calibration method when the 
composite transmission line above is terminated with 50 ohms. This scan is highlighted 
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with dots along each of the three traces: SWR, Zmag, and Phase.  The SWR shows some 
variation. The phase angle is off about 15 degrees at 1.95MHz. 

Then a scan was done using custom calibration data obtained at the end of the 
transmission line.  The new data is plotted with plain lines. Now the data is flat, 
indicating a nearly ideal 50 ohm termination. The phase angle is essentially zero; it lies 

on the x-axis so it’s not easy to see. 

  

 

The figure above shows the results when using an LC parallel turned circuit for a load. 
One scan was taken with the LC circuit connected directly to the AIM’s RF connector 
using standard cal data. 

Then the LC circuit was moved to the end of the composite transmission line (shown 
previously) and another scan was done with the custom cal data.  When the two scans are 
overlaid, they are very close to each other. This before and after comparison was done by 
loading a new cal data file without changing the scan limits. Then click Rescan and the 
new scan overlay the original data.  The same type of comparison can also be done by 
loading a stored graph file and clicking rescan. 
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This scan shows the effect of a High Pass Filter that has high attention in the AM radio 
broadcast band. It is very effective in reducing interference picked up on a 160 meter 
antenna. The filter’s cutoff frequency is about 1.6 MHz.  To cancel the effect of the filter 
in the 160 meter band (1.8 to 2.0 MHz), the custom calibration procedure can be used.  

Below 1.6MHz, the cal data is noisy due to the attenuation through the filter. This is 
because the instrument sees essentially the same thing when any of the calibration loads 
are attached, so the compensation data is not consistent with the specific load. Above 
1.6MHz the signal through the high pass filter is normal, with low attenuation, and the 
calibration is accurate. The 50 ohm load read accurately in the frequency range of 
interest, 1.8 to 2 MHz.  

When using new filters or baluns that may have limited bandwidths, be sure to 

evaluate the results using loads with known characteristics before testing the 

antenna itself.  
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                                             Line Extension 

When an adapter is used to connect a line to the AIM, there will be some shift in the 
displayed parameters due to the phase shift in the adapter.  This can be compensated by 
doing the regular calibration with the adapter in place. Alternatively, it can be 
compensated after calibration by treating the adapter as an extension of the transmission 
line and reversing the phase shift.  The extension is assumed to be a short piece of ideal 

coax (no loss) with a specified length, characteristic impedance (Zo) and velocity factor.  
There is no limit to the length, but typically the extension will be short. The default unit 
of length is centimeters. The length can be entered in inches, feet, or meters by following 
the number with an “i”, “f” or “m” (upper or lower case can be used).  

The length can be positive or negative. Enter zero to turn the extension function off. 
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This graph shows the effect of inserting an adapter in series with a piece of RG59/U coax 
that is terminated with a 200 ohm resistor.  

A- The first trace for the phase crosses the frequency axis at 58.8 MHz.  

B- When the adapter, which is 6.5 cm long is inserted, the phase plot crosses at 56.5 
MHz since the line appears to be longer now and the frequency corresponding to a 
half wavelength is lower.   

C- Enabling the line extension function with length=6.5 cm, Zo=50, and Velocity 
Factor=1 compensates for the extension and the last trace coincides with the first 
trace that was made without the extension.  

Note the value for Zo corresponds to the adapter that is being compensated,  not to 
the transmission line.  Depending on the construction of the adapter, it may take some 
experimentation to find the equivalent length. Only the electrical length, not the physical 
length, is important for this function, so the velocity factor can be left at 1.0 if desired.    
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                       Rulers and Offsets 

Horizontal rulers can be defined to help visualize where a parameter lies with respect to  
user specified limits.   Two rulers can be defined for: SWR, Phase, Zmag, Rseries, 
Xseries, and Return Loss. These are referred to as Ruler 1 and Ruler 2.  Either one can 
have the larger value. 

 

The rulers are displayed as dashed lines with the same color as the trace they are related 
to.  The numeric value is displayed at the left end of the ruler. 

The ruler display can be turned on or off without affecting the value of the rulers by 
clicking Rulers ON/OFF.  All the rulers can be set to zero by clicking Clear All Rulers. 
This applies to both Ruler set 1 and Ruler set 2. 
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                       Rulers for SWR (red), Zmag (green) and Phase (magenta)
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The traces can be offset by a specified amount to make it easier to see small variations 
around an average value.   

 

After the trace is offset, the Scale can be expanded to highlight the interesting part of the 
trace.  Click the Scale button at the bottom of the screen to call up the Scale factor 
selection dialog. 

For example, the quality of a dummy load can be evaluated by offsetting the Zmag and Rs 

data by 50 ohms and then expanding the vertical  Zmag scale to 10 ohms full scale for 

better sensitivity 

The offsets can be turned off without having to change the offset values by clicking 
Offsets ON/OFF.  Clicking this tab again re-enables the offsets. 

All the offsets can be set to zero by clicking Clear All Offsets. 

The value of the offset is displayed at the left side of each parameter.  If these labels 
interfere with the some traces, the labels can be turned off while leaving the offsets in 
effect.  Click Labels ON/OFF. 
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                                  Scan Differences 

When evaluating changes to a system, it is sometimes interesting to plot the difference 
between scans.  This feature makes it possible to save a scan as a reference and then 
subtract it from each subsequent scan.   

 

The scan that is presently being displayed can be saved as the reference by clicking 
Difference of Scans => Save Ref 

This reference will be saved indefinitely in memory as long as the program is active. It is 

cleared when the program is closed or when the scan limits are changed.  The 
differencing operation can be turned on and off by clicking Enable Scan Difference.  

This does not affect the reference itself.  The reference scan can be recalled for viewing 
at any time by clicking View Ref.  The reference is not affected by this operation.  The 
reference scan is not saved with the init file when the program is closed.   

When the differencing operation is enabled, a reminder is displayed in the lower left 
corner of the graph. The difference applies to Zmag, Phase, Rs and Xs.  Any of these 
traces can be turned off, if desired.    

New scale factors and offsets can also be used to expand the difference traces.  
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This example shows how the effect of a small impedance change at the end 
of a cable can be highlighted. 

 

This shows a piece of RG58 coax 28 feet (8.5m) long, terminated with a 100 ohm 
resistor.  

                 This is saved as the Reference scan for this example. 



 Antenna Analyzer AIM                                                                                         page 59 

 - 59 - 

Now we'll add a 33 pf capacitor in parallel with the resistor: 

 

A Rescan shows the effects with both terminations superimposed.   
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Displaying the difference between these scans makes it easier to see the effect of the 
33pf of stray capacitance: 

 

The differences can be highlighted even more by plotting Zmag and Phase on larger 
scales.  The difference can be displayed in the Recycle mode while tuning a circuit or 
antenna.
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                            Smith Charts 

Click on the button labeled “Smith” at the bottom of the graph to open a window with a 
Smith chart showing a plot of the reflection coefficient versus frequency. As the cursor is 
moved with the mouse over the original scan, a marker dot is displayed at the 
corresponding point on the Smith chart and the relevant data is displayed on the right side 
of the graph. 

Note, the point that is highlighted on the Smith chart corresponds to the frequency on the 
horizontal frequency axis of the graph. This graph may be under the Smith chart and the 
horizontal axis, hence, it may not be completely visible. The Smith chart window can be 
moved to optimize the display.  A red dot marks the start of the Smith chart trace. 

A green circle of constant SWR will be displayed when the SWR Ruler #1 (see the 

Setup menu) is set to a value greater than 1.0.  A second SWR ruler #2 can also be used.  
It will be plotted in blue.  The SWR reference values for the rulers are shown in the left 
side of the Smith chart window.  

In the Point Data tune mode, the impedance value can be displayed in real time on the 
Smith chart. 

The center of the Smith chart corresponds to Zref=50 ohms in the example below. The 
Zref value is specified using the Setup Menu. Zref can be any value and it can be a 
complex number. 

Buttons in the upper right corner of the Smith chart window provide for zooming by 
factors from 1x to 5x.  When the second Smith chart is displayed, it can have a different 
zoom value.  (see Marker Menu) 

 
Smith charts of the same scan with zoom values of 2x and 5x. The right hand Smith chart 
has an offset of 45 electrical degrees. (geometrical plot rotation is 90 degrees)  
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When the Smith chart has a complex trace, it may be helpful to highlight the data for each 
cycle around the center by plotting with different colors.  This feature can be turned on 
and off by clicking the Colors button in the lower right hand corner of the Smith Chart.  
 

 
               Standard Smith Chart                                      Color Highlighting    
 
 

          
Reflection Coefficient in rectangular and polar coordinates     
 
The electrical length of the line at a particular frequency is displayed in the lower right 
corner of the Smith chart.    
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Admittance scales can also be displayed.  Click the Admittance button to turn these 
scales on or off.   The Impedance scales are always on.  The colors of  the scales are 
specified by four parameters near the bottom of the Config file.  These are in the same 
RGB format used to specify the colors for the regular plots.  For example, 
the three numbers on the line represent Red, Green, and Blue with values between 0 and 
255.  Zero means there is no color and 255 represents the brightest value.  For example, 
Red = (255,0,0)  Maximum Red and no green or blue 
Green = (0,255,0) 
Blue = (0,0,255)   
White = (255,255,255)   red, green and blue are all at maximum intensity 
Black = (0,0,0)               no red or green or blue 

Gray = (128,128,128)    
 

 
                   Smith Chart with Admittance and Impedance Scales



 Antenna Analyzer AIM                                                                                         page 64 

 - 64 - 

     

                                           DSP Filters 
 
The DSP filters are used primarily with the PowerAIM when testing antennas that 

are subject to strong interfering signals from radio stations on or near the same 

channel. 

 

 
 
DSP filters 1 & 2 -  A station on the same channel may cause a small but noticeable 
disturbance of the scan where you want to make a measurement. This interference can 
often be eliminated by using the DSP filters. 
 
These filters have two parameters: center frequency & scan width.  The center 

frequency does not have to correspond exactly to the point where the noise is centered. 
Also, there can be more than one burst of noise in the scan range. Typically the scan 
range will be small, no more than 100KHz for signals in the AM broadcast band and up 
to 1MHz in the FM band.  The scan range is specified by its half-width. The scan will be 
between f1 and f2 corresponding to the center frequency minus the half-width and the 
center frequency plus the half-width. The numbers can be entered in kilohertz by 
following them with a “K” or “k”. 
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If 0.0 is entered for the center frequency, the DSP filter will process the data already in 
memory from a previous scan. This is useful for processing data saved in scan files. 
Otherwise, a new scan will be done with the specified scan limits and this new data will 
be processed.  
 
The two filters use different techniques and one may work better that the other, 
depending on the situation. The calculated data will be superimposed using a heavy line 
over the original data so you can see its effect.  The new trace can be displayed by itself 
by clicking on a function that causes the display to be refreshed, for example, click the 
scales button and then enter.     
 
An example is shown below using DSP filter 1:  
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ORIGINAL SCAN:     BEFORE PROCESSING WITH DSP FILTER 1: 

 
 
AFTER PROCESSING WITH DSP FILTER 1:  
(heavy lines are new data after filtering)   

 
 
In the example above, the heavy, highlighted lines are shown so it’s easier to see the 
effect of the filter. Red corresponds to SWR, orange to Rseries and yellow to Xseries. 
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Below are two screen shots showing the effect of using DSP filter 2. The interfering 
signal in this scan was injected using a transmitter feeding one antenna while the 
PowerAIM was scanning another nearby antenna.  
 
ORIGINAL SCAN: 

 
 
AFTER PROCESSING WITH DSP FILTER 2:  

  



 Antenna Analyzer AIM                                                                                         page 68 

 - 68 - 

 

                           TDR (Time Domain Reflectometry)  
 
The TDR feature enables measurement of transmission line impedances and lengths even 
when they are not open or shorted at the far end.  This is also very useful when two or 
more different types of transmission line are connected in series. For example, 50 ohms 
and 75 ohms.  The distance to the antenna can be measured without having to disconnect 
the line from the antenna.   
 
For many years TDR's have been built with analog pulse generators and oscilloscopes. 
This requires a wideband scope (or a sampling scope) but basically the system is 
straightforward.  This was the only practical way to implement TDR before low cost 
powerful computers became available. 
 
 

 
 
This diagram shows the basic components of a TDR.  The test pulse has a rise time that is 
short compared to the times to be measured.  Typically the pulse has a sharp leading edge 
and it is much wider than any time to be measured.  The trailing edge of the pulse is not 
used. This is called a step function.  The  amplitude of the pulse is not critical since the 
measurements involve  ratios.  In this figure the amplitude is 10 volts.  (It could be a low 
amplitude pulse too.) 
 
The output of the pulse generator is a voltage source. The leading edge of the pulse steps 
up to 10V at time T=0 and the voltage seen at point A is always the same regardless of 
the load that is connected.  
 
There is a resistor in series with the output of the pulse generator, typically this is 50 
ohms.  For this example, a piece of  coax is connected to the output  which has a 
characteristic impedance, Zo, of  50 ohms. This test coax is 100 feet long and it has a 
velocity factor of 0.66. 
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The scope is connected to point B.  Keep in mind that at T=0, the coax looks like a 50 
ohm resistor to the wave that is starting to travel down it.   During the initial transient 
stage this value of Zo will apply until the wave has time to travel all the way to a 
discontinuity in the system and be reflected back.  If there is no discontinuity and the 
wave travels down the line forever or is absorbed by a load resistor at the end, then the 
impedance at point B will continue to be Zo forever.   In a typical case, a  ideal 50 ohm 
coax terminated with an ideal 50 ohm resistor looks like 50 ohms at DC and at all RF 
frequencies.  In actual practice, loss in the coax and skin effect complicate things 

somewhat but we won't worry about that for now. 

 
The 50 ohm resistor in series with the generator output and the Zo of the transmission 
line form a voltage divider of 50 ohms and 50 ohms, so one half of the voltage appears at 
point B at T=0.   
 
The wave would travel down the coax at the speed of light, which is about 1 foot per 
nanosecond, but the dielectric material in the coax slows it down.  The velocity factor  is 
the actual velocity of the wave through the dielectric divided by its velocity if the coax 
did not have a dielectric (that is, the speed of light in air) .   Typically this is in the range 
of 0.66 to 0.9, depending on the material used for the dielectric.  The dielectric makes the 
line appear to be longer than it really is, that's why a quarter wave coax stub is shorter 
than a quarter wave length of the signal in air. 
 
The voltage step in this example takes 150 nsec to travel down the coax to the open end. 
A scope probe at point C will see a step that is 10 volts high but it's delayed by 150 nsec 
with respect to the step seen at point A  (the 50 ohm series resistor has negligible delay).    
 
 Wait a minute, the voltage at point B was only 5 volts and now we have 10 volts at point 

C.  How did that happen?  In fact, a scope probe placed anywhere along the coax will see 
the 5 volt step traveling down the line for the first 150 nsec.  When it gets to the open end 
of the coax, the wave is reflected in phase and the 5 volt step now becomes 5 + 5 volts to 
form the 10 volt step seen at point C.  Now, as we watch the signal travel back down the 
line, its amplitude is 10 volts. When the reflected wave reaches point B, the probe at 
point B sees 10 volts.  It takes 300 nsec for the wave to travel down the line and back.  
The scope can measure this time which is two times the electrical length of the coax.  If 
the velocity factor is known, then the physical length of the line can be calculated by 
multiplying the electrical length by the velocity factor. 
 
The 50 ohm resistor in the generator is the same as the Zo of the test line, so there is no 
reflection at the generator and the final value seen at point B is 10 volts.   It takes a short 
time (usually nanoseconds or microseconds) for the voltage to reach its final value.  This 
time delay usually isn't a factor for ordinary radio communication .  For high speed data 

communication, it can be a factor when the delay is comparable to or even greater than 

the time interval between data bits. 

 

In this example, the wave at the open end of the coax was reflected in such a way that it 
was positive and it added to the incoming wave. The ratio of the reflected signal to the 
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incoming signal is called the reflection coefficient.   Anytime there is a change in the 

impedance, there will be a reflection.  In this special case the reflection is equal to the 
incoming signal so the reflection coefficient is +1.  Another interesting case is when the 
end of the coax is shorted. In this case the reflected signal will be inverted and it subtracts 
from the incoming signal so the wave that travels back toward the generator has an 
amplitude of 5-5=0 V.  The reflection coefficient is -1.  In this case, the voltage at point B 
will drop to zero after 300 nsec, which is what you expect since an ohmmeter at point B 
will read zero ohms due to the short circuit.    In summary, the reflection coefficient is 
always in the range of  +1 to -1.  It can't be greater than one because the reflected wave 
cannot be greater than the incident wave.   
 

                                 
 
Here's a practical example where the coax is terminated in a 100 ohm resistor which does 
not match the characteristic impedance of  50 ohms. The line is said to be mismatched. 
To help visualize what is going to happen, let's look at the final state of the voltage after a 
long time has elapsed.  The generator is outputting 10V, there is a voltage divider of 50 
ohms and 100 ohms, so the final value at point B has to be 6.66 V after things have 
settled down.  The question is how long does it take for this steady-state result to be 

reached?  

 
In the previous examples with an open circuit and a short circuit, the reflection 
coefficients were +1 and -1 respectively. 
 
The general formula for the reflection coefficient, RHO, is: 
 
        RHO = ( Zload - Zo )/( Zload + Zo )  
 
where Zload is the load at the far end of the line and Zo is the characteristic impedance of 
the line.   We can check this for the two extreme cases, one when Zload is infinite (open 
circuit): 
  
             RHO= (infinity - Zo)/(infinity + Zo) = +1 
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When Zload=0: 
  
                RHO=(0 - Zo)/(0 + Zo) = -1 
 
For values of Zload between zero and infinity, RHO varies between -1 and +1. 
 
Therefore, for the above diagram, RHO = (100 - 50)/(100+50) = +0.33 
 
This means that if the incoming signal has an amplitude of 5V, the reflected wave will 
have an amplitude of 5*0.33 = 1.66V and it will add to the incoming wave so the final 
value at point C at T=150 nsec is 5+1.66 = 6.66V.  This reflection of 1.66 V travels back 
down the line and after another 150 nsec it arrives back at point B and the voltage at point 
B jumps up to 6.66V.  Thus the final voltage at B and C is 6.66V just as we expected 
from the preliminary analysis when we treated the circuit as a simple voltage divider. 
 
By measuring the reflected wave at Point B, we can work backward and calculate what 
Zload must be to cause this reflection.  The following diagram shows the measurement 
point B expanded. 
 

 
 
The reflection coefficient is the value of the second step, v2, divided by the value of the 
first step, v1.  Note that v2 is a negative number when Zload is less than Zo. 
 
 Zload =  Zo* ( 1 + RHO)/( 1 - RHO) 
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Let's check some special cases for measured values of RHO: 
 
V1 and V2 can be measured with a scope. 
 
If the line is open:  v2 = v1   
Then RHO = v1/v1 = +1 
Then Zload = Zo * ( 1 + 1)/( 1 - 1) = infinity  
 
If the line is shorted:  v2 = -v1   
Then RHO = -v1/v1 = -1 
Then Zload = Zo * ( 1 - 1 )/( 1 + 1 ) = 0 
 
If the line is terminated with 100 ohms:  v2 = 0.33*v1  
Then RHO =  0.33v1/v1 = 0.33 
Then Zload = Zo * ( 1 + 0.33)/( 1 - 0.33) = 50 * 2 = 100 ohms 
 
If the line is terminated with 50 ohms: v2=0 (no reflection)   
Then RHO = 0/v1 = 0 
Then Zload = Zo * ( 1 +  0 )/ ( 1 - 0) = Zo = 50 ohms              
               
If the line is terminated with 30 ohms:  v2 = - 0.25*v1   
Then RHO = -0.25v1/v1 = - 0.25 
Then Zload = Zo * ( 1 - 0.25)/( 1 + 0.25) = 50 * 0.60 = 30 ohms 
 
This is a brief introduction to the basic principles of TDR.  In recent years the increased 
power of  low cost computers has made it possible to create a TDR in software using the 
data from a frequency scan of a circuit.  The vector network analyzer first collects data 
for the reflection coefficient at a number of frequencies. Then mathematical operations 
convert the frequency data to the corresponding time data.  In this way the analyzer, 
which is basically a frequency domain instrument, does double duty by providing both 
frequency and time domain data with no extra cost in hardware.    
 
An interesting Application Note on TDR fundamentals can be found here: 
Agilent Ap note 1304-2 
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An interesting thing that can be done with a TDR is determine the impedance and  
lengths of several different cables in series.  This diagram shows data from an AIM for a  
transmission line made up of three lengths of coax with nominal impedances of 50, 75  
and 53 ohms.  The composite line is terminated with 50 ohms.  The numbers along the 
 horizontal axis are distance.  
 

 
 
The first section of line has a measured impedance of 51 ohms and it's 5.8 feet long. The 
second section has a measured impedance of 74 ohms and it is (11.4 - 5.8)=5.6 feet long. 
The third section is (17.4 - 11.4) = 6.0 feet long. 
 
Multiple reflections quickly complicate the interpretation of a TDR scan.  
This web page has an excellent presentation on a technique for the Analysis of reflections    
http://home.comcast.net/~howard.heck/3-1.ppt       
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This picture shows the TDR picture of a simple trap dipole antenna feed with a 53 ohm 
coax that is 23 feet long (indicated by the vertical cyan cursor).  Since the antenna is a 
relatively narrow band circuit, its impedance is very high over most of the frequency 
range scanned by the TDR. This causes a large jump in the reflection coefficient at the far 
end of the coax, so it's possible to determine the length of the transmission line without 
disconnecting it from the antenna. 
 
In this case the antenna is an open circuit for DC, so the impedance is very high at the 
feed point. If the antenna has a DC path to ground at the feed point, the TDR trace will go 
to zero ohms at the end of the transmission line.    
 
The final steady state impedance displayed by the TDR is the same impedance that would 
be measured at DC.   Depending on the horizontal scale, this final value may not be 
reached because of multiple reflections in the system.                     
 
The resolution in distance is approximately 0.25% of full scale for the AIMuhf and 0.5% 
of full scale for the AIM4170 and the PowerAIM.  For distances greater than 200, the 
three instruments have essentially the same resolution.   
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                       TDR Operation 
 
 

 
 
 
TDR Mode on/off - alternates between the normal Frequency mode and the TDR mode. 
 
Linear Z Scale - If this is checked, the vertical Z display is a linear scale. If it is not 
checked the vertical scale shows RHO on a linear scale and Z is a function of RHO. 
 
Show RHO Scale - If this is checked, RHO will be displayed on the vertical axis along 
with Z. 
 
Lines/Dots - Plot the trace with continuous lines or dots at each measurement point.  
 
Velocity Factor -  Enter the velocity factor used for calculating distance based on 
electrical length. The same value is used for the whole transmission line system when 
multiple cables are involved.  The typical value is 0.66 to 1.0.  The electrical length can 
be displayed on the graph by setting the Velocity Factor = 1. 
 
Meters/feet - Display distance data in meters or in feet.  (meters can be selected as the 
default in the config file) 
   
High Resolution - Increases the resolution along the distance axis by approximately 2x.  
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In the TDR mode, these functions work similarly to the way they do in the 

frequency mode: 
 
Scan - clear the screen and do a TDR scan.   The AIM takes a series of  impedance 
readings, converts these readings to the reflection coefficient at each frequency and then 
transforms the frequency data to time data using the inverse Fourier transform. 
 
Rescan - do a TDR scan without erasing the screen. The color of the plot cycles through 
five different colors. 
 
Scales - enter the distance and Zmag scales. 
 
Halt - stop a scan 
 
Quit - exit the program 
 
The buttons at the bottom of the screen that are not used in the TDR mode are grayed out. 
 
On the Files Menu (upper left corner of the screen), the same menu items are used for 
saving TDR graphs and recalling them from memory. 
 
The AIM uses the same calibration file and config file in both the frequency mode and 
the TDR mode. 
 
Setup -> Ruler 1 and Ruler 2 - Rulers for Zmag can be used.       
 
Setup -> Average Reading - The averaging is normally set to zero (no averaging) but it 
can be turned on while in the TDR mode.       
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                                                  CURSOR DATA 

 
 
This figure show how data at two points can be displayed along with their differences by 
moving the cursor to the first point and pressing a 1 on the keyboard, then move the 
cursor to the second point and press 2.  This action can be repeated by moving to other 
points and pressing 1 or 2. Data in the small window will be updated each time.  The two 
selected distances  are indicated by blue vertical lines on the graph.  Close the data 
window by clicking the X in the upper right corner.  
 
The data at the cursor position is displayed in the upper right corner of the main window 
just like it is for the frequency mode.  In this diagram, the mouse cursor is all the way to 
the right side of the graph at Distance=50 and the line impedance is 100.51 ohms.  The 
value of Zo (Zref ) is used for calculating the reflection coefficient. This can entered by 
using the Setup menu. 



 Antenna Analyzer AIM                                                                                         page 78 

 - 78 - 

 

                           AIM Principles of Operation 

      The AIM4170 is based on the same technology used in the AIM430 and AIM4160. 
      The AIM430 was featured in an article in the Nov 2006 issue of QST magazine.            
          

1. An RF voltage is applied to the transmission line input.  
To reduce the chance for interference to nearby radio receivers, the maximum 
output power is less than 20 microwatts (-17 dBm). 
 

2. Measure the applied voltage and the current flowing into the load. The current is 
measured across a precision resistor which has a much wider bandwidth than a 
transformer.  (The AIM does not use any RF transformers). The current sensing 
resistor does not have to be adjusted and it has excellent long-term stability.  
 
 

 
 

3. Calculate the magnitude and phase of the input impedance.  The magnitudes and 
phases of the applied voltage and resultant current are measured with an analog to 
digital converter (12-bit ADC) and their ratio determines the magnitude of the 
impedance.  The sign of the phase is also measured so that capacitive and 
inductive reactances can be distinguished.  
 

4. The signal processing circuits are linear, so the nonlinearity problem inherent with 
diode detectors is eliminated. 
 

5. Calculate various parameters including: SWR, equivalent input resistance and 
reactance, cable length, cable loss.  A large number of parameters can be 
calculated using the fundamental impedance measurement.  The load is assumed 
to be an antenna but the data is displayed in such a way that discrete capacitors 
and inductors can be measured too.  These values are plotted versus frequency 
and the exact numeric data can be read by moving a cursor to the point of interest. 

 
 
 



 Antenna Analyzer AIM                                                                                         page 79 

 - 79 - 

 
 Block diagram of the AIM4170: 
 

 
 

The AIM uses two Direct Digital Synthesizer (DDS) chips. One generates the test signal 
and the other acts as a local oscillator to heterodyne the RF signals to the audio range. 
You can read about the basic principles of the DDS at this address: 
http://www.analog.com/library/analogDialogue/archives/38-08/dds.pdf  

 

A 50 MHz crystal controlled oscillator drives both of the DDS chips.  Inside the DDS, the 
clock is multiplied by a factor of 8, so the effective clock rate is 400 MHz.  Program 
frequency resolution is a fraction of a Hertz. The output of each DDS goes to a 170 MHz 
low pass filter to remove the harmonics and aliases of the digitally generated signal. The 
output of the low pass filter is a sine wave in the range of 0.1 MHz to 170 MHz.  Any 
amplitude variations or phase shift in the low pass filters do not affect the measurement 
accuracy since they affect the current and the voltage channels equally and thus cancel 
out when the ratio is taken. 
 
The output of one DDS supplies the test voltage and current to the load impedance and 
the other DDS acts as the local oscillator to heterodyne the voltage and current signals 
down to 2 kHz.  Audio amplifiers boost the 2 kHz signals and drive the input to the 12-bit 
analog to digital converter (ADC) that is inside the MSP430 microprocessor. This 
microprocessor is mounted inside the AIM case. The raw data is sent from the 
microprocessor to the external PC.  The PC calculates the various data values and 
displays them graphically. 
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Reflection Coefficient:  
 
To find the SWR (standing wave ratio) of an antenna, we first calculate the reflection 

coefficient. This is the ratio of the voltage that is reflected at the antenna to the voltage 
that arrives at the antenna from the transmitter. If all the power from the transmitter is 
radiated into space, there is no reflection, the reflection coefficient is zero and the 
SWR=1.0.   
 
The following discussion uses the concept of complex numbers. A tutorial on complex 

numbers is available in Appendix 1. 

 
Reflection_Coefficient = Rho = ( Zload – Zo ) / ( Zload + Zo ) 
 
Zload = antenna impedance 
Zo      = transmission line impedance 
 
Note that in general, Zload and Zo are complex numbers of the form:  
 
Zload = Ra + jXa   and   
Zo = Ro + jXo. 
 
Xo, which is the imaginary part of Zo, is often neglected since it is usually small 
compared to the real part, Ro.    
 
Since Zload is a complex number, the reflection coefficient, Rho, is also a complex 

number. 
  
The reflection of the incoming power from the transmitter is caused by a mismatch 
between the transmission line impedance (Zo) and the impedance of the antenna at 
the operating frequency.  For example, if the transmission line has an impedance of 50 
ohms and the antenna is a dipole with an impedance of around 75 ohms, there is a 
mismatch and some of the power is reflected even though the antenna itself may be very 
good. If the transmission line is changed to 75 ohms, the match is much better, there is 
less reflection and the SWR is closer to 1.0. 
 
In the special case where the transmission line is open at the antenna (due to a broken 
wire), all of the power that arrives at this open circuit will be reflected back toward the 
transmitter and the reflection coefficient is 1.0 and the SWR= infinity.  Another 
interesting case is when the transmission line is shorted at the antenna terminals.  Again, 
all the power will be reflected (none is radiated) but the signal is inverted, so the 
reflection coefficient is now –1.0 (minus one). The magnitude is still unity (that is, +1) 
and the SWR=infinity. 
 
Thus, we see that the magnitude of the reflection coefficient will be in the range of zero 
to 1.0 for any combination of transmission line and antenna.   
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The reflection coefficient also has an associated phase angle, Phase, between the incident 
voltage from the transmitter and the reflected voltage. The real and imaginary parts of 
Rho can be related to its magnitude and phase angle with the following equations:   

Real_part_of_Rho          = rhoa = Magnitude_of_rho * COS(Phase) 

Imaginary_part_of_Rho = rhob = Magnitude_of_rho * SIN(Phase) 

Rho = rhoa + j rhob 
 
 
Standing Wave Ratio (SWR): 

 
SWR is the ratio of the Maximum Voltage to the Minimum Voltage along a transmission 
line.  On a perfectly matched line, the maximum is equal to the minimum since there is 
no variation in the voltage along the line and the SWR is 1.0.  In the real world, SWR is 
somewhere between 1.0 and infinity.  The special case of infinity means all the power 
from the transmitter is reflected back by the antenna. This would the case for a short 
circuit or an open circuit at the antenna when using a lossless transmission line. 
 
If the transmission line has no loss, the SWR is the same at all points along the line. That 
is, the SWR at the transmitter is the same as it is at the antenna.   As the transmission line 
loss increases, the effect is to make the SWR measured at the transmitter appear to go 
down since less power is received back from the antenna. This power gets lost along the 
transmission line, so it does not arrive at the SWR meter and the meter responds more to 
the outgoing power from the transmitter. The meter thinks the antenna is a better match 
than it really is because there seems to be less reflected power.    
 
The SWR only depends on the magnitude of the reflection coefficient, Rho: 
 
 SWR =  [ 1 + magnitude(Rho)] / [ 1 – magnitude(Rho)] 
 
This shows that when the magnitude of Rho = 0 (that is, the transmission line and the 
antenna are a perfect match), the SWR is [1+0]/[1-0] = 1 (this is the ideal case). 
 
When the mismatch is very large and the magnitude of Rho is nearly 1, the term in the 
denominator approaches zero and the SWR approaches infinity. 
 
Since only the magnitude of Rho appears in this equation, SWR is not a complex number 
(it’s a real number). 
 
For calculations involving complex numbers,  a very useful program can be found here: 
SpeqMath.com 
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                 Measurement of Crystal Parameters 
 

Quartz crystals can be modeled as shown below: 

 

The series resonant frequency is the lower of the two frequencies. It’s determined by L 
and Cs. The higher parallel resonant frequency is determined by L and Cp+Cs.   

A broad scan can be done to locate the resonant frequencies. They will be displayed at 
the top of the screen. Typically, these two frequencies only differ by a few kilohertz. 
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                         Automatic Crystal Parameter Calculation 

The calculations to find the crystal 
parameters are tedious so they have been 
combined into a procedure than can be 
called from the Functions menu.  First click 
“Measure Crystal”. 

Be sure the AIM has been calibrated with 

the cal loads at the point where the crystal 

will be connected.  

Then enter the series resonant frequency.  

This should be within 100KHz of the series  
resonant frequency.  When measuring an 
overtone crystal, enter the appropriate 
harmonic frequency. 

 
 

After a few seconds the crystal parameters 
will be displayed 

The data can be saved in a file. If the file 
already exists, the data will be appended 
(added) to it. If the file does not exist, a 
new one will be created with the .xdat 
extension. 

This file is compatible with programs that 
read comma separated variables (*.csv) 
files, like Excel.  A legend is included at 
the beginning of the file to show the 
variable name in each column. An Excel 
utility can be used to sort the data to 
determine the best crystals to use for a 
particular crystal filter. 

If the Parallel Capacitance is more than 
20 pf it will highlighted in red because this 
may indicate there is excessive stray 
capacitance in parallel with the crystal due 
to long leads.  
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The following discussion goes into more detail about the crystal calculations.   

After the resonant frequencies are located, you can change the scan limits to focus in 
more detail on the region of interest. 

At the series resonant frequency, the reactances of L and Cs cancel out and the magnitude 
of the impedance becomes equal to R. Therefore, the series resistance of the crystal can 
be read directly at the minimum value of Zmag on the graph (where Phase = 0).  The 
numeric value is Rs in the Data Window.  

 

At frequencies well below the series resonant point, the impedance value is the total 
capacitance, Ctotal, which is essentially equal to Cparallel.  Cparallel is read at a 
frequency equal to 78% of the series resonant frequency. 

          Cparallel = 3.5119 pF    

The value of Cseries is given by: 

           Cseries = Cparallel * 2 * (Freq_parallel  - Freq_series ) / Freq_series 



 Antenna Analyzer AIM                                                                                         page 85 

 - 85 - 

 

Where Freq_parallel is the parallel resonant frequency and Freq_series is the series 
resonant frequency. 

          Freq_series = 12.095902 MHz 

          Freq_parallel = 12.121317 MHz 

           Cseries = 3.5119pF * 2 *(12.121317 – 12.095902)/12.095902 = 0.0147577 pF 

The inductance of L is given by: 

         L = 1 / ( 4 * pi*pi * Freq_series * Freq_series * Cs ) 

         L = 1/(4*pi*pi*12.095902MHz^2*0.01476pf)  = 11.7313 mH 

        Rseries = 8.911  (= Zmag where Phase =  0) 

        Reactance_of_ L = 2*pi*Freq_series*L = 891.588 K 

        Q = Reactance_of_L / Rseries = 100059 

 



 Antenna Analyzer AIM                                                                                         page 86 

 - 86 - 

Frequency Source 
 
 
When the AIM or AIMuhf is used as a signal source, DO NOT connect it directly to the 
antenna connector of a transceiver. If the transmitter is accidentally turned on, the output 
will exceed the AIM's maximum safe input level. 
  

 
 
The AIM can be used as a signal source for testing electronic circuits, such as radio 
receivers.  The programmed frequency has an initial accuracy of +/-30ppm for the 
AIM4170 and PowerAIM.  The AIMuhf will be within +/-2 ppm of the specified 
frequency .  It can be calibrated with respect to WWV or with a frequency counter at 
10MHz.   The AIMuhf has a temperature compensated oscillator (TCXO) and it will stay 
within 0.2ppm for several hours.   
 
The AIM4170D and the AIMuhf have an option to set the output amplitude over a range 
of 100% to 10% when using Custom Cal or the Constant Frequency mode. The amplitude 
of the output is not regulated by an AGC circuit but it is flat within 1 db across the high 
frequency (HF) amateur bands.   
 
The AIMuhf is limited to 200 MHz in the constant frequency mode because the output 
signal becomes very complex due to the presence of several aliases at high frequencies. 
 
The nominal signal delivered to a 50-ohm load by the AIM4170 and the AIMuhf  is about 
30mV rms.   
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Enter a frequency value in the text window and click “Enter”. The frequency can then be 
incremented or decremented by clicking the +/- buttons. 
 
The output frequency of the AIM can be calibrated with a frequency counter or a radio 
station with a known accurate frequency.   The  AIM has to be tuned to within 2KHz of 
the specified cal frequency for the calibration to be effective.  The cal frequency can be 
any value up to 200 MHz.    
 
For example, to calibrate the frequency to WWV, tune in WWV at 10MHz and adjust the 
AIM output to zero beat with it. Then click the “cal” button shown in the dialog box 
below.  There is an option to enter the exact frequency, the default value is 10 MHz. This 
will apply a correction factor to all frequencies that are programmed later. The correction  
is also saved in the .ini file and it's automatically recalled each time the program starts up. 
The value of this correction factor can be seen in the Status Window (click Help -> 
Status).   
 
The frequency calibration factor can be reset to 1.00 by clicking the button called "Set 

Freq Comp = 1.00". 
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         Inductance / Capacitance Measurement 
 
When testing components it is often convenient to have a visual display of the inductance 
or capacitance as a function of frequency.  This shows at a glance how the parameter 
varies without having to read the cursor data at each frequency point.  When displaying L 
or C the vertical scale on the left side of the graph is used.  Only L or C can be plotted at 
one time.  L and Q can be plotted at the same time.  
 
The parameter to be plotted is selected using the Setup => Plot Parameters menu.  The 
data is numerically the same as the cursor data displayed on the right side of the graph. 
The L corresponds to Xseries (Xs) and C corresponds to Xparallel (Xp).  If the sign of 
the  reactance changes during a scan, a note appears at the bottom of the graph to indicate 
the component is not purely inductive or capacitive over the specified frequency range. 
 
 

 
 
This figure shows a family of  inductance curves for coils with 1 to 4 turns on a ferrite 
core of type 43 material. The bottom red trace corresponds to 1 turn and the others 
correspond to 2, 3 and 4 turns.  The value in microhenries is shown on the left axis.  The 
magnitude of the impedance (green) and the phase angle (magenta) are also displayed. 
The Zmag and Phase traces are optional and they can be turned off if desired by using the 
Setup =>Plot Parameters menu. 
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This family of traces shows the inductance for 1 to 5 turns on a type 61 core.  The bottom 
red trace corresponds to one turn and the top red trace is five turns. The inductance is less 
than it was when using type 43 material because the permeability of type 61 is less.  
However, the inductance is flatter across the frequency range. 
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This plot shows a 100 ohm resistor in parallel with a 33 pf capacitor. The value of Rp and 
Cp are flat across the range.  The trace labels  (R, C, X) on the left are used to highlight 
the traces. 
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 Appendix 1– AIMUHF  Specifications 

Frequency Control:  Digital Synthesizer 5 KHz - 1000 MHz 

Frequency Accuracy: +/- 2 ppm (TCXO settable to WWV or a counter @ 10MHz) 
 
Frequency program step size:  0.1 Hz min to 10 MHz max 
 
Calibration: software controlled (no screwdriver adjustments). 

ADC resolution: 12 bits. 

Measurement Ranges: 

SWR: 1 to 20 

Impedance:  1 ohm to 5K ohms up to 60 MHz,  2K ohm to 200MHz, 600 ohms to 1GHz 

Accuracy:  1 ohm +/- 2% of reading up to 60 MHz  
                   5% of reading up to 500 MHz         
                  10% of reading up to 1GHz 

Phase Angle: +/-90 degrees (true phase) 

Parameters displayed include: SWR, Reflection coefficient, Q, Return loss, Magnitude of load 
impedance, Phase angle of load impedance, Equivalent series resistance and reactance, 
Equivalent parallel resistance and reactance. Reactance is shown as inductance (uH) or 
capacitance (pF) according to the phase angle.  

Two Smith Chart displays with zoom, phase offset and markers. 

Data can be referenced to the antenna terminals. 

RF Output:  Programmable 0.2 to 20 microwatts (-17dBm) max.  Type-N connector standard.  

Spurious output:  –30dBc or better below 200 MHz 

Max allowable RF input while measuring: 140mV peak  (-7dBm)  

Max safe RF input: 2V peak (+16dBm)  

PC Interface: USB cable included 

Display: Graphics output on PC screen.  Mouse controlled cursor for digital parametric readout. 
Markers for highlighting user specified frequencies. Audible tone and speech output for SWR to 
assist in making adjustments without watching the PC monitor.   

Power Requirements:  8 to 15 VDC at 500mA max (120VAC power supply included) 

Dimensions (approx):  5” x 4” x 1.5”  (12.7 x 10.2 x 3.8 cm) 

Software updates are available from  W5BIG.com  (no cost).  
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                    AIM4170C / AIM4170D  Specifications 

Frequency Control:  Digital Synthesizer 5KHz - 170 MHz ; Stability: +/- 30 ppm 

Frequency Step Size:  1 Hz to 10MHz 

Calibration: software controlled (no screwdriver adjustments). 

ADC resolution: 12 bits. 

Measurement Ranges: 

SWR: 1 to 20 

Impedance:  1 ohm to 5K ohms up to 60 MHz,  2K ohm to 170MHz 

Accuracy:  1 ohm +/- 2% of reading up to 60 MHz  
                  5% of reading up to 170 MHz 

Phase Angle: +/-90 degrees (true phase) 

Parameters displayed include: SWR, Reflection coefficient, Q, Return loss, Magnitude of load 
impedance, Phase angle of load impedance, Equivalent series resistance and reactance, 
Equivalent parallel resistance and reactance. Reactance is shown as inductance (uH) or 
capacitance (pF) according to the phase angle.  

Two Smith Chart displays with zoom, phase offset and markers. 

Data can be referenced to the antenna terminals. 

RF Output: 20 microwatts max; UHF connector standard (UHF connector standard,  N- optional) 

Spurious output:  –30dBc or better 

Max allowable RF input while measuring: 140mV peak  (-7dBm)  

Max safe RF input: 2V peak (+16dBm)  

PC Interface: RS232. Data rate = 57.6K or 115K baud. An optional USB/RS232 adapter is 
available when ordering the AIM. The AIM4170D includes the usb adapter inside the case. 

Display: Graphics output on PC screen.  Mouse controlled cursor for digital parametric readout. 
Markers for highlighting user specified frequencies. Audible tone and speech output for  SWR to 
assist in making adjustments without watching the PC monitor.   

Power Requirements:  7 to 15 VDC at 250mA max (120VAC power supply included) 

Dimensions (approx):  5” x 4” x 1.5”  (12.7 x 10.2 x 3.8 cm) 

Software updates are available from  W5BIG.com  (no cost)  
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                      PowerAIM Specifications 

Frequency Control:  Digital Synthesizer 0.1 - 120 MHz ; Stability: +/- 30 ppm 

Frequency Step Size:  1 Hz to 10MHz 

Calibration: software controlled (no screwdriver adjustments). 

ADC resolution: 12 bits. 

Measurement Ranges: 

SWR: 1 to 20 

Impedance:  1 ohm to 2K ohms 

Accuracy:  1 ohm +/- 5% of reading up to 60 MHz  
                  10% of reading up to 120 MHz 

Phase Angle: +/-90 degrees (true phase) 

Parameters displayed include: SWR, Reflection coefficient, Return loss, Magnitude of load 
impedance, Phase angle of load impedance, Equivalent series resistance and reactance, 
Equivalent parallel resistance and reactance. Reactance is shown as inductance (uH) or 
capacitance (pF) according to the phase angle.  

Two Smith Chart displays. One can be phase shifted with respect to the other. 

Data can be referenced to the antenna terminals. 

RF Output: 2 milliwatts max; type-N connector standard. 

Spurious output:  –30dBc or better 

Max stray RF input while measuring: 25V peak.  

Max safe RF input: 50V peak.  

PC Interface: RS232.  Data rate = 57.6K or 115K baud. An optional USB/RS232 adapter is 
available when ordering the PowerAIM . 

Display: Graphics output on PC screen.  Mouse controlled cursor for digital parametric readout. 
Morse code output for selected parameters.  Up to 20 markers for user specified frequencies. 

An audible tone related to SWR can be output to assist in making adjustment without watching 
the PC monitor.  

Power Supply:  12 VDC at 500mA max (12V battery and 120VAC battery charger included) 

Battery power source can range from 11 to 16V. Required current is approximately 500mA when 
a measurement is in process, 100mA when idle.  Auto-power-off after 10 minutes of inactivity.  

Dimensions (approx):  5” x 4” x 2”  (12.7 x 10.2 x 5.1cm) 
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                         Appendix 2 – Complex Numbers 

Calculations with complex numbers are very tedious to do manually.  A free program that 
is very useful for this purpose is called SpeqMath.  It's available at www.SpeqMath.com.  
All data variables in SpeqMath are assumed to be complex numbers, so you don't have to 
worry about declaring data types.  SpeqMath uses the symbol "i" instead of "j" to indicate 

the square root of  -1. 

Complex numbers are so called not because they are complicated but because the are 
made up of two parts: a real part that we are accustomed to using for most everyday 
problems, and an imaginary part.  The imaginary part was introduced to handle the square 
root of negative numbers.  In ordinary circumstances, any number squared is positive, so 
it seemed unreasonable for a negative number to have a square root. This was resolved by 
defining a special value called “the square root of minus one”.  This is usually 
symbolized by “i” in math books and by “j” in engineering books.  Using “j” avoids 
confusion in an engineering context with the symbol “i” that is usually used for current.   

 
Complex numbers came into use about 500 years ago for solving algebraic equations, 
including the familiar second order equation: ax^2 + bx + c = 0. 
 
(note: the symbol x^2  means “the value of x squared”= x times x.) 

 
Let’s look at a specific example:  x^2 – x – 2 = 0. 
In this case the coefficients are:  a = 1,   b = -1,   c = -2 
 
The solutions using the quadratic equation are: 
 
  x = [ - b + SQRT( b*b – 4ac) ] / 2a 
 
and 
  
 x = [ - b - SQRT( b*b – 4ac) ] / 2a 
 
 
Inserting the coefficients of the equation, we get: 
 
x = [1 + SQRT(1 + 8)]/2 = 2 
 
and  
 
x = [1 – SQRT(1+8)]/2 = -1 
 
Now, if we go back and insert x = 2 into the equation, the equation is equal to zero and 
we also get zero by plugging in x = -1. 
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There is no problem here since we didn’t have to worry about the square root of a 
negative number. 
 
A small change of one coefficient changes the mathematical problem considerably, as we 
will see now: 
 
Let the equation be:   x^2 – x + 2 = 0  
 
a = 1,   b = -1,  c = +2 
 
Changing “c” from –2 to +2 gives us: 
 
x = [1 + SQRT(1 – 8)]/2  
 
 and 
 
x = [1 – SQRT(1-8)]/2  
 
Now we have to deal the problem of evaluating the square root of –7. 
 
We write this as:  -7 = (-1) * (+7) 
 
Note the SQRT(A*B) = SQRT(A)*SQRT(B), so SQRT(-7) = SQRT(-1)*SQRT(+7). 
 
The SQRT(+7) is 2.646 and SQRT(-1) we define as “j”, so SQRT(-7)=j*2.646. 
 
One solution to the equation is: 
 
x = [ 1 + j2.646 ]/2 = 0.5 + j1.323 
 
To confirm that the value x=0.5+j1.323 actually does cause the equation to equal zero, 
we have to do some arithmetic with complex numbers.   
 
Addition is straightforward: 
 
The real part of one number is added to the real part of the second number. 
Similarly, the imaginary part of one number is added to the imaginary part of the second 
number. 
 
  (a + jb) + (c + jd) = (a+c) +j(b+d) 
 
For example:   ( 1 + j4 ) + ( 5 + j8 ) = (5+1) +j(4+8) = 6 + j12 
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Multiplication is a little tricky: 
 
The two complex numbers have to be multiplied term by term: 
 
(a+jb)*(c+jd) = a*c + jb*c + a*jd + jd*jb   
 
We get 4 terms.  Note that j*j = -1, so the last term = -d*b  (this is a real number) 
 
The first and fourth terms are real, so we can add them directly to get: (a*c – d*b) 
 
The second and third terms are imaginary, so we can them to get:  j*(b*c + a*d) 
 
The final result is:  
 
(a+jb)*(c+jd) = (ac – db) + j(bc + ad) 
 
This is tedious. Fortunately, the computer is good at this sort of thing, so we usually don’t 
have to worry about the details. 
 
Now we’ll finish checking our equation by plugging in one of the answers that we found: 
  
Let x = 0.5+j1.323 
 
x*x = (0.5+j1.323)*(0.5+j1.323) = - 1.50 + j1.323 
 
Then, the whole equation =  (-1.50+j1.323)  - (0.5+j1.323) –2 = 0   (good) 
 
To relate complex numbers to electrical circuits, we make the following observations: 
 
Resistance is a real number. 
 
Inductive reactance is a positive imaginary number. 
 
Capacitive reactance is a negative imaginary number. 
 
The impedance of a circuit is: 
 
Z = R + jX,    X = reactance and it can be positive (inductor) or negative (capacitor) 
 
For example, suppose we have a 100pF capacitor (100*10^-12 Farad) in series with a 500 
ohm resistor and the frequency is 7 MHz. 
 
At 7 MHz, the capacitive reactance X= -1/(2*pi*7000000*100*10^-12) = -227 ohms 
 
Note: the minus sign is very important. 
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Z = 500 – j227 = impedance of the series R-C circuit. 
 
Real_part_of_Z  =  Re(Z) = 500 
Imaginary_part_of_Z  =  Im(Z) = -227 
 
The magnitude of a complex number is the square root of the sum of the squares of the 
real part and the imaginary part: 
 
Magnitude_of_Z = SQRT( 500*500 + 227*227) = 549 ohms 
 
The phase angle, Phase, associated with this complex number can be calculated by: 
 
Phase = ArcTangent(Imaginary_part / Real_part) 
          = ArcTangent(-227/500) = - 24.4 degrees 
 
The negative angle is characteristic of a capacitive circuit. It means the voltage is trailing 
(or lagging) the current.  In an inductive circuit, the phase angle is positive since the 
voltage leads the current. 
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                      Appendix 3 – Hot Keys 

The following keyboard keys can be used instead of clicking buttons with the mouse: 

S – Scan (same as Scan button) 

R – Rescan (same as Rescan button) 

L – Enter new Limits (same as Limits button) 

D – Get raw data in Point Data mode (S, Z and T can be output in Morse code if desired). 

U – Do a scan and save the data in a file named $AutoScan$.csv for off-line processing       
by a program such as Excel. 

Q – Exit the program  

Left Arrow – Move the cursor to the left on the graph. 

Right Arrow – Move the cursor to the right on the graph. 

Up or Down Arrow – Swap the last two scans. (either key can be used)  

Control+UpArrow will overlay the last two scans if the scan limits are the same. 

Left mouse button – Disable the cursor movement (reverse this action with a flag in 
Setup Menu.) 

Right mouse button – Enter markers. 

1 -  Enter Data Cursor 1 at the present cursor position 

2 - Enter Data Cursor 2 and perform the Min, Max, Avg functions on the data between    
Cursor 1 and Cursor 2. 

   . 
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                                Appendix 4 – RS232/USB Operation  

When the AIM program is updated to a new version, the comm port will still be the same.  
Before loading the new version, make a note of the original comm port by clicking: 

 Setup -> Enter comm port.  The default value in the dialog box is the present comm 
port.  That's what you will enter after loading the new program.  This port value can also 
be found by looking at a text file called:  Version_xxxxxx.txt.   This file is in the same 
folder as the earlier version of the AIM exe file.   

Because some newer computers don’t have RS232 ports, it may be necessary to use an 
RS232 to USB adapter with the AIM.  The AIM’s RS232 port uses only three wires. Pin 
2 is the data from the AIM to the computer, pin 3 is the data from the computer to the 
AIM and pin 5 is ground.  Hardware handshaking is not used.  The signal amplitude on 
the I/O lines (pins 2 and 3) is approximately +/-5V. 

The comm port assigned to the USB adapter can be found using the Windows Device 

Manager: Click Start � Settings �Control panel � System � Hardware � Device 
Manager. 

If there seems to be a problem with the USB adapter, here are some tips for checking it. 

First, make sure another accessory in the computer or another program is not tying up the 
comm port.  For example, if the AIM program is started two times without closing it the 
first time, the second copy cannot use the comm port. This can happen when the first 
AIM window gets hidden behind another window so it’s not obvious that it is still active. 

When the AIM hardware first powers up, it sends out a character string that can be 
received by any terminal emulation program, such as HyperTerminal.  To use 
HyperTerminal, which is a standard accessory in Windows, click on the Start button in 
the lower left corner of the Windows desktop. Then, click “Programs” -> “Accessories” -
> “Communications”  -> “HyperTerminal”.  Set HyperTerminal for the following 
parameters: 

 Baud rate=57600; 8 data bits; 1 stop bit; no parity;  echo typed characters locally. 

When HyperTerminal is ready, turn on the AIM power.  The green LED on the AIM 
front panel will turn on and the text displayed on the computer terminal is the following 
(or similar): 

Antenna Analyzer AIM 

from Array Solutions  

  Oct 13, 2006 

 
If this is displayed, it means the data from the AIM to the computer is okay.  If the text is 
not displayed, a scope or logic probe can be used to check for pulse activity on pin 2 of 
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the RS232 connector with the PC cable disconnected. Pin 5 of this connector is the 
Ground pin.  The normal voltage at pin 2 is about –5V and it pulses to about +5V several 
times during a 1 second interval while the text string is output right after the power is 
turned on.  The PC doesn't have to be present at all, so this output test is completely 
independent of the PC or the operating system.  

To check data from the computer to the AIM, type K1 (K and a one).  Note the K is 
upper case. The command K1 will cause the AIM to turn on its Red LED.  There is no 
character space between the K followed by a 1, but the time interval between typing the 
K and the 1 is not critical.  Then, type K0 (K followed by a zero). The Red LED should 
go off.  This indicates the AIM is able to receive commands from the computer; 
therefore, the I/O data link is working properly. 

It has been found that sometimes the computer operating system will say the USB driver 
is properly installed when it really isn’t.  Deleting the driver and then starting over and 
specifying that the driver must be reloaded from the CD may work.    

A problem has also been found where Windows may not properly keep track of which 
comm port is in use. Some problems with the comm port can be solved by removing the 
port numbers that have been assigned in the past but which are no longer in use. This link 
has information for cleaning up the port assignments.  

Check this web page for the latest information on the interface: 
www.w5big.com/FAQ.htm 

------------------------------------------------------------------------------------------------------------ 

 The following information on the USB interface applies to the  AIMuhf, the 

AIM and the VNA2180. 

 
Connect one end of the USB cable to the AIM (or VNA) and the other end to a USB port 
on your PC.  You many need a new USB driver. (Many computers will already have the 
appropriate driver.)  The USB interface chip used in the VNA2180 is made by FTDI 
(www.ftdichip.com).  The chip is called FT232R and the recommended driver for several 
versions of Windows is 2.04.16. A link to it is on this page: 
http://www.ftdichip.com/Drivers/VCP.htm 
 
If your computer is connected to the internet at the time you first plug in the USB cable,  
Windows XP, Vista and Win7 may be able to find the driver automatically on the 
internet. This may take two or three minutes.   
 
After the driver is installed and it has assigned a port number to the AIM, use the 
Windows Device Manager to find the comm port number.  Click "Start" in the lower left 
corner of the screen, then click "Control Panel", "System", "Hardware", "Device 

Manager".  The comm port number will be shown in a list of i/o ports similar to this:  
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 Under the AIM Setup menu tap at the top of the AIM 
program screen, click on Enter Comm Port and enter 
the port number  that was assigned by Windows. This 
number will be saved in the setup file called 
AIM_xxx.ini.   The default comm port number may be 6 
or 5. 
 
The usb interface can be customized for improved 
performance. Double click on the line that says "USB 
Serial Port (COMxx)".  The General Properties dialog 
will pop-up: 

 
 
Click on the tab that says "Port Settings". 
 



 Antenna Analyzer AIM                                                                                         page 102 

 - 102 - 

 
 
 
The Bits per second (baud rate) does not matter. 
 
Click on the button labeled "Advanced" (this button may be overlapping the Flow 
Control edit box). Click on the outer edge of the Advanced button.  
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The COM Port Number can be changed, if desired.  Make a note of this number; this is 
the value that will be entered into the AIM program for the comm port.  Change the 
parameter called "Latency Timer" from 16 to 1.  This will speed up the communication.  

It has been found that sometimes the computer operating system will say the USB driver 
is properly installed when it really isn’t.  Deleting the driver and then starting over and 
specifying that the driver must be reloaded from the CD may work.   Sometimes, deleting 
the device manager for this port and  then plugging the cable back into the computer will 
cause the PC to reinstall the correct driver.  

Check this web page for the latest information on the interface: 
www.w5big.com/FAQ.htm 

 The AIM programs has been used with Windows 2000, XP, Vista and Windows 7.  They 
have also been used with the MAC.   
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                            Appendix 5 – Scan Data File Format 

The scan data can be saved in two different formats that are suitable for importing into 
spreadsheets or plotting programs. 

In one file with the extension “.csv”, only the basic data is saved in the following order: 
 
Frequency in MHz, SWR, Rseries, Xseries, Zmag, Phase(deg), Reflection coefficient, 
Return loss(dB), Percent reflected power. 
 
The data values for one frequency are all on one line and are comma delimited.   
This file can be easily imported into a spreadsheet for detailed analysis.   

Another file with the extension “.scn” is saved with more information about the 
conditions of the scan.  A detailed example is show below. 

 

// The comments are not included in the actual file. 

// Parameters included in this file:  SWR, Rseries, Xseries, 

// Zmagnitude, Phase 

// 

// If the equivalent parallel load circuit is needed: 

//  Rparallel=Zmag*Zmag/Rseries 

//  Xparallel=Zmag*Zmag/Xseries 

// 

09-08-05  10:57:33    // first line, date and time of the scan 

 110                  // program version (changes if the data format             

                      // changes) 

 20                   // number of data points minus 1 : 

                      // (there are 21 data blocks below) 

 12                   // scan start frequency (MHz) 

 22                   // scan end frequency 

 0.500000000000000    // step frequency between test points 

 12                   // freq at left side of graph plot (MHz) 

 22                   // freq at right side of graph plot (may not be 

                      // the same as "scan end freq"  

 10                   // swr full scale 

 1000                 // z magnitude full scale 

 100                  // phase full scale (degrees)  

 22.500000000000000   // not used 

 0                    // not used 

 0                    // not used 

 0.500000000000000    // freq spacing between major vertical lines on 

graph  

 1                    // plot_swr flag (1=true) 

 “comment string”     // graph comment string, if any.  

1010.010620117187500  // SWR :  Start of data blocks; 5 items per block  

                      // repeated 21 times in this example 

 0.892523407936096    // Rseries : equivalent series resistance of load 

 206.328903198242190  // Xseries : equivalent series reactance of load 

 206.330841064453120  // Zmagnitude : magnitude of load impedance 

 1.566470623016357    // Phase : angle of load impedance, radians 

 440.064605712890620  // next SWR 

 2.952029705047607    // next Rseries, etc 

 249.890869140625000 
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 249.908309936523440 

 1.558983564376831 

 284.346221923828120  // SWR 

 7.125505924224854 

 314.254211425781250 

 314.334991455078120 

 1.548125863075256 

 202.912612916039060  // SWR 

 17.597200393676758 

 419.200958251953120 

 419.570159912109370 

 1.528843045234680 

 158.592254638671870 

 49.341548919677734 

 621.562377929687500 

 623.517761230468750 

 1.491579294204712 

 134.716033935546880 

 205.956863403320310 

 1158.638305664062500 

 1176.801147460937500 

 1.394876122474670 

 123.570953369140620 

 4566.038085937500000 

 2713.321289062500000 

 5311.385742187500000 

 0.536173224449158 

 114.446578979492190 

 421.559051513671870 

 -1494.078613281250000 

 1552.411987304687500 

 -1.295792102813721 

 108.322395324707030 

 105.496887207031250 

 -746.862121582031250 

 754.276245117187500 

 -1.430471181869507 

 102.702613830566410 

 49.549240112304688 

 -499.510437011718750 

 501.961944580078120 

 -1.471924185752869 

 97.688926696777344 

 29.741893768310547 

 -376.700836181640620 

 377.873107910156250 

 -1.492006182670593 

 91.975608825683594 

 20.779895782470703 

 -304.370910644531250 

 305.079406738281250 

 -1.502630472183228 

 88.663787841796875 

 15.381784439086914 

 -255.856430053710940 

 256.318389892578120 

 -1.510749816894531 
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 80.219047546386719 

 12.850700378417969 

 -221.102661132812500 

 221.475799560546870 

 -1.512740731239319 

 76.584655761718750 

 10.647170066833496 

 -195.356231689453120 

 195.646148681640620 

 -1.516348838806152 

 68.956077575683594 

 9.652303695678711 

 -175.194458007812500 

 175.460159301757810 

 -1.515757203102112 

 65.095878601074219 

 8.543374061584473 

 -158.872634887695310 

 159.102188110351560 

 -1.517073035240173 

 61.215835571289063 

 7.745326042175293 

 -145.441238403320310 

 145.647323608398440 

 -1.517592549324036 

 58.022541046142578 

 7.089697837829590 

 -134.253402709960940 

 134.440475463867190 

 -1.518036961555481 

 53.652206420898437 

 6.746065139770508 

 -124.731056213378910 

 124.913352966308590 

 -1.516764044761658 

 50.906970977783203     // last SWR (21 data blocks in all) 

 6.325359821319580      // last Rseries 

 -116.475082397460940   // last Xseries 

 116.646713256835940    // last Zmagnitude 

 -1.516543030738831     // last phase 

 50                     // real part of transmission line 

                        //impedance (ohms) 

 0                      // imaginary part of transmission line 

                        // impedance 

 0                      // transmission line type 

 0.660000026226044      // transmission line velocity factor                           

 0                      // cable length 

 1                      // meters or feet scale factor 

 1                      // plot Xseries flag  

 1                      // plot Rseries flag 

 0.000000045816051      // Next five values are calibration data, not            

                        // needed by spreadsheet 

 0.000000000007380 

 -0.025273719802499 

 1.023359417915344 

 100.599998474121090    // last line 
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               Appendix 6 - Battery Operation  

The AIM can be powered with a battery for portable operation.  Battery voltage can range 
from 8.0 to 15V. The required current is 250mA (400mA for the AIMuhf) when a 
measurement is in process and 50mA when idle.  The power is turned off automatically 
after 10 minutes of inactivity when the Auto-Power-Off feature is enabled (this is an 
option in the SETUP menu at the top of the screen).  

Suitable batteries include a conventional 9V battery or a 12V car battery. The easiest way 
to connect the battery is to use a barrel connector like the wall power supply uses. This is 
a 5.5x2.1mm barrel connector. The Mouser part number is: 1710-2120. 

 
When using the AIM to test a mobile antenna on a motor vehicle, it is better to use a 
separate battery and not the 12V battery in the vehicle.  A 9V battery will power the unit 
for several hours or a small 12V gel cell (sealed lead acid) battery can be used for 
extended operating periods.  This avoids the problem of sneak paths through the ground 
between the DC power input and the antenna ground connection.  It will also help reduce 
measurement noise if it’s necessary to run the engine while taking data (such as to 
operate the air conditioner).  If it’s essential to get power for the AIM from the 

vehicle, be sure to put 500 ma fuses in BOTH the +12V lead and the power ground 
lead.  A small voltage drop across the fuses will not affect the AIM since the battery 
voltage is much more than the required minimum operating voltage.   The laptop 
computer being used should remain floating for the best measurement accuracy. 
 

A 9V battery can be installed inside the AIM. There are diodes on the card to 
automatically select either the wall power supply or the internal battery. The power on/off 
switch will disconnect the battery too, so the off-state current drain is only about 1 
microamp.     

Refer to the Applications file under the Help menu for more information on battery 
operation.  
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J4 is the power connector 
on the rear panel. The 
wall power supply (or 
external battery) plugs in 
here. D1 and D11 are a 
cross-over circuit to select 
either the external or 
internal power source, 
whichever is more 
positive. The battery 
positive and negative 
connections are labeled on 
the pc board.  

R54 is an optional resistor 
for trickle-charging a 
rechargeable battery. This 
is a user-selected resistor. 
It is not included in the 
AIM but there is a space 
on the PCB for mounting 
a through-hole resistor.  

 

This photo shows how an 
optional battery or battery 
pack can be connected to 
the printed circuit board.  
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                         Appendix 7 – Saving Screen Shots 

Pictures of the scan can be very useful for documentation.   The easiest way to paste a 
screen into a program, such as Microsoft Word, Photo Shop,  or Paint Shop Pro is: 

1: Press Alt-PrtScr to copy the image to the clipboard 

2: Move the cursor to the desired document or paint program and press Control-V.  

A nice freeware utility is called “PrintScreen” from Gadwin: 
http://www.gadwin.com/printscreen/ 

This utility installs very easily. It can save the whole screen, the current window (the one 
with its top banner highlighted), or a rectangular area that you can select. For saving  
shots of the AIM data, the current window is probably the most useful choice. This 
should be saved in gif or png format, not jpg.  Gif and png formats save a better quality 
graphic image than jpg. (jpg is better for photographs.)  

Newer versions of Windows have a utility called Snipping Tool that can be used to save 
screen shots too. Look in the list of Accessories files. 

You can save the screen in .bmp format by clicking:  File ->Save Image Bitmap  

The Windows operating system also includes a standard accessory program called 
“Paint” that’s already available on all computers.  

 To run “Paint”, click the Start button in the lower left corner of the screen.  

Then click “Programs” 

Scroll to find “Accessories” 

Click “Paint” 

Click Control-V to insert the screen shot into the working page. 

Then save the file as a .gif , .png, or .jpg. (.gif or .png are preferable since the quality of 
the line drawing is better than it is in jpg) 

Now your screen shot can be inserted into a document file or attached to an email. 
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                            Appendix 8 – Configuration File 

The configuration file (*.cfg) is used to set the screen colors and some other display 
parameters.   The config file can be edited with any text editor, including Notepad.  There 
is an editor included with the AIM program, click Help -> Edit Config File. 

 A utility called colors.exe is included with the AIM software to aid in selecting screen 
colors. Move the sliders to get the desired color combination. Note the numeric values for 
red, green, and blue and then enter these values in the config file using a text editor.  
Several different config files can be resident in the same folder. They are selected using 
the menu option: File -> Load Config File.  

Comments are included in the config file itself. 

============================================================== 

Screen size = 1250x800   

-- config_version=109     Leave this line in place, unchanged. 

-- The comment above will be displayed when the config is loaded from the menu. 

-- It does not have to start with the -- symbols. 

-- There can be several config files in the same folder. This comment is 

-- helpful to differentiate them. 

-- April 28, 2015 

-- AIM configuration file 

-- The parameters must remain in the same sequence but extra blank lines and  

--comments can be inserted. 

-- When new parameters are added, they will be placed at the end of the file. 

-- Comments or blank lines can be inserted freely. 

-- Comments are indicated by a double-slash / /  or a double-dash -- 

-- Earlier config files with double-slash delimiters are still compatible. 

-- Be sure not to use both double-slashes and double-dashes in the same config file. 

-- The double-slash or double-dash should start in column 1. 

-- If the config file is not found in the same folder as the exe file, default parameter 
-- values will be used. 

 

-- COLORS for PLOTTING: 

-- Colors are entered as RED, GREEN, BLUE with values 0-255 

-- 0=no color, 255=maximum color (max red, max green, or max blue) 
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-- Examples:  0,0,0 = black   255,255,255=white 

--           255,0,0=bright red   0,255,0=bright green   0,0,255=bright blue 

 

-- The included utility file: colors.exe can be used to help select the colors. 

-- The numbers should be in decimal format. 

-- A space or comma can be used to separate the three numbers. 

 

-- Only the first number (or set of 3 numbers for colors) on each line is used. 

-- The rest of the line is a comment. 

-- A double-slash or double-dash on a line means the rest of the line is a comment. 

 

-- When experimenting with colors, the new set of colors can be entered on the same 

-- line and the old ones are pushed to the right.  

-- The old ones will be ignored by the program but they are handy for reference. 

 

-- There are two sets of colors for each parameter: 

-- The brighter color is used for the main scan (first scan) 

-- A fainter shade of that color is used for the rescan (second scan) 

 

  240,0,0      -- RED=SWR (or reflection coefficient) main scan and Smith Chart trace 

  240,120,0  --   light red=SWR (or reflection coefficient) rescan 

 

  0,180,0           --  Green=Zmagnitude main scan 

  130,240,180   --  light green=Zmagnitude rescan 

 

  200,0,200       --  Magenta=Theta main scan 

  200,180,240   --  light magenta=Theta rescan 

 

  0,200,200     --  Cyan=vertical cursor that is moved with the mouse. 

 

  64,100,252     -- Blue=Return Loss main scan 

  150,150,250   --  light blue=Return Loss rescan 
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  150,150,0     --  Yellow=Xs or Xp (whichever is selected) main scan 

  200,200,0     --  light yellow=Xs or Xp rescan 

 

  230,120,0       --  Orange=Rs or Rp main scan 

  255,195,125   --  light orange=Rs or Rp rescan 

 

  250,250,200    -- 180,220,255  smbackground=Smith Chart background color 

 

  210,210,210   --  grid color=color of gridlines on the graph 

   

  200, 0,  0      -- file name color (cal,config,cable_cal file names displayed on screen) 

 

  1    -- Cursor ena: This flag has been moved to the Setup menu item called: "Cursor 
normally on" 

--               The config file flag has no effect now. 

   

-- Graph line width: 

    2   -- = Line width of the plotted data (can be 1,2,3,4,5...) 

 

    0      -- unused parameter 

-- 

--  BAND SELECTION:   Start_freq, Stop_freq, Delta_freq (all in MHz) 

--  The actual "Stop_freq" on the graph will be equal to or greater than the 

--  value specified here.  

--  The frequencies specified DO NOT have to correspond to hamradio bands. 

--  The frequencies and the delta freq can be any value within the range of the AIM. 

 

--  If you don't use a particular band and don't want it to be highlighted, 

--  set the start_freq=0, stop_freq=0, delta_freq=1 

 

-- The comma should follow immedately after the start_freq and stop_freq values. (no 
space) 

-- The string after "station=" is a user supplied string to IDENTIFY the band 
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-- on the menu. It can be up to 12 characters long but it cannot have any spaces. 

-- (Use an underline or a dash character instead of a space.) 

-- Instead of "station=", the term:  "band=" can be used to indicate a particular band. 
"station" and "band" are equivalent. 

-- If the delta_freq is greater than 20, it will be interpreted as the "number of data points" 
rather 

-- than a value in MHz. 

 

    1.7, 2.1,   0.01,  station=160_meters    --  all of these values can be user specified. 

    3.4, 4.1,   0.02,  band=80_meters        -- band and station are equivalent terms 

    5.3, 5.50,  0.005, band=60_meters 

    6.9, 7.4,   0.01,  station=40_meters 

   10.1, 10.20, 0.005, station=30_meters 

   13.9, 14.5,  0.01,  station=20_meters 

   18.0, 18.20, 0.005, station=17_meters 

   20.9, 21.6,  0.01,  station=15_meters 

   24.7, 25.1,  0.01,  station=12_meters 

   27.9, 29.8,  0.05,  station=10_meters 

   49.5, 54.5,  0.10,  station=6_meters 

   143.5,148.5,  0.10,  station=2_meters 

 

    1.00, 150.00, 1.0,  station=Band_A    -- (Bands A..D are not highlighted on the graph) 

    1,  30, 0.2 ,  station=Band_B 

    3,  33.00, 0.1 , station=Band_C 

    50.00, 54.00, 0.02,  station=Band_D 

 

    230,230,255   -- highlight color for the ham frequency bands on graph 

    30000    -- max number of data points. This can range from 20 to 30K.  

         0     -- meters/feet (1 means use meters as default length, 0 means use feet as                     
                -- default) 

 

     200    -- Max delay in milliseconds for external hardware 

               --   (for example, Bluetooth) to respond to the RS232 data link. 
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-- Parameters to set graph and font sizes: (new with version 600) 

-- If the max width and height are larger than the actual screen size, 

-- the full screen size will be use. 

-- The earlier versions of the AIM program used a max graph size of 950 x 600. 

 

  1200      --   max graph width in pixels  (original AIM graph width was 950 pixels) 

    800      --  max graph height in pixels (original AIM graph height was 600 pixels) 

 

    8    -- Default font size. 5 is very small, 6 and 7 are medium, 8 is large. 

         --  minimum font value=3, maximum font value=10 

 

   1    -- Bold Data display ( 0=not bold data ) 

 

  1300    --  Max freq for AIMuhf  300 to 1600 MHz 

             --  (recommended absolute max is 1200 MHz)  

             -- Spec limit for AIMuhf  is still 1000 MHz.  May 8, 2015 

             --  (Some units may work at higher frequencies) 

        

  300     -- Delay in milliseconds while recycling. Several seconds may be useful in some 
cases. 

 

  1        -- one means RS232=115K,  0 means RS232=57.6K,  May have to use "0" for  
            -- Bluetooth 

  1       -- issue cal warning if long stub is attached while calibrating 

           --  (change to 0 => "don't warn me, I feel lucky".) 

  2.0    -- parameter 3 

  0.3    -- parameter 4 

  32     -- xtal averaging 

  1      -- external program control: 1=disable 2=enable-don't display time, 3=enable &    
          -- show time 

 

  1     --  auto save graph after each scan, 0=don't save 
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-- The next two lines are path names for the external control input and output: 

-- The names controlfile= and outputfile= must appear first on the line. 

-- The 'controlfile' is actually a key in the registry. 

-- The 'output' file is a regular file on the hard drive (or flash drive). 

-- The exact position of these strings on the line is not critical. 

-- The file and path names can be anything, they don't have to be on the C drive. 

-- Don't enclose the path names in quotes. 

-- Use double back-slashes for folder delimiters. 

-- The path names CANNOT have spaces in them. Use dashes or underscores. 

-- All valid filename characters are ok except spaces. 

-- The string after the path name is a comment, it can be anything 

 

 controlfile= hkey_current_user\software\AIMVNA\     : input control key initiates scan  
   

 outputfile= C:\\temp\\AutoScan.csv                  : output data csv file 

 

-- Voice output parameters: 

 

 voicefilefolder=Sounds_1\\     Folder for voice sounds (wav files) 

   1       -- num_digits=1 or 2 in fractional part for voice output 

   5      -- 0=Don't repeat the same number, 1=Repeat the same number. 

 

  1     -- parameter_10 

 

-- if Zmag changes too much between data points, issue an alert:  

 

   4     --  = Tolerance for Zmag change per point as a percentage of full scale, e.g,  4=4%  
          --  of full scale, 5=5%, 10=10%, etc.   

          -- the alert can be made less sensitive by entering a larger number, e.g., 100 will  
          -- disable it.   

          -- The data will be valid even when the alert appears.  
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 25   -- Auto plot zero --- automatically turn off the "Start plot at Zero" flag if the start  
        -- freq is greater than this Percentage 

        -- of the end freq.   "Start plot at zero" can still be turned on/off manually. 

        -- For example, if this parameter = 25, then when FreqStart=50 and FreqEnd=100,                
        -- the plot at zero flag is set to zero unless 

        --  it is manually turned on. 

        -- Enter 0 to disable automatic operation of the "Start plot at Zero" flag. 

 

-- Colors for scales on the Smith Chart:  added 2-14-15 

  

  0,0,0                 -- Black = Impedance resistive scales 

  200,0,200         --  Magenta = Impedance reactive scales 

  0,180,0             --  Green = Admittance resistive scales (conductance) 

  64,100,252       --  Blue = Admittance reactive scales (susceptance) 

     

--  END of config file 
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                    Appendix 9 –  Component Test Fixture 
 
The AIM can be used to measure small 
discrete components over a specified 
frequency range.  A convenient way to hold 
them is with a BNC to binding post 
adapter. Even though the adapter has 
significant stray capacitance and 
inductance, these stray parameters can be 
cancelled by the calibration procedure.  
The adapter shown here is from Jameco, 
part number 99355, which costs about 
$5.30 in the U.S.A. 
 (ref: www.jameco.com) 
 
When calibrating, insert a piece of wire 
between the binding posts for the short 

circuit. Then remove the wire for the open 

circuit. The resistor that is used can be 
any 1/4W or 1/8W carbon or metal film 
resistor with an accurately known value.  A 
resistor in the range of 50 to 500 ohms can 
be used. 

 

 
For testing very small surface mount 
components, another adapter can be made 
from a small piece of printed circuit board 
material. A cut down the middle isolates 
the two side.   A similar cut is also made on 
the back side if the printed circuit board has 
copper on both sides. Two heavy wires 
(#16 - #20) can be used to connect it to the 
binding posts. The chip component being 
tested can be held securely by pressing it 
against the board with the eraser of a pencil 
or a plastic screwdriver.  
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Here we see the surface mount adapter 
combined with the binding post adapter.  
The stray capacitance of this combination 
adapter will also be compensated by the 
calibration procedure.  Capacitors in the 
picofarad to nanofarad range and inductors 
in the nanohenry to microhenry range can 
be measured. 

 
 
 
Components can be tested with a DC bias by using a circuit similar to this:      
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             Appendix 10 – External Program Control 

In Nov 2011 a new method was developed for controlling the AIM with functions in a 
DLL.  These functions can be employed in any language and they give the user full 
control of the data collection,  processing and display.  A separate document is available 
with the title:  AIM_Software_Guide.pdf.  This document (with a link to the demo 
program) is included in this zip package to show how the DLL functions can be used. 

 

A description of the original external control method follows: 

The AIM can be integrated with a test system so that measurements are done under the 
control of a “Master” program.  A new procedure has been incorporated in program 
version 700B which is more robust than the earlier version.   

 By using this procedure, the calibration and data processing in the AIM program are 
employed automatically and the user can focus on analyzing the final data that is output 
to a file in CSV (comma separated values) format.  This file can be read by Excel or the 
user's custom program. 

The Master program communicates with the AIM by data strings in the registry.  The 
scan data from the AIM is written to a CSV file in the same format that it was before. 

The three parameters sent from the Master to the AIM are: Start_freq, End_freq, and 
Delta_freq.  The frequency values are in megahertz.  After these parameters are written 
to the registry, the AIM will read them, perform the scan and write the csv file. It then 
puts the name of the csv data file in the registry so the Master knows the scan is complete 
and the data is ready.   

To enable external control, set the flag in the config file to 2 or 3: 

3   external program control: 1=disable 2=enable-don't display time, 3=enable & show time 

If the flag is set to "3", a one second timer is displayed in the upper left corner of the 
screen. 

The names of the registry key and data file are specified in the AIM config file: 

controlfile= hkey_current_user\software\AIMAIM\    : input control key initiates scan (this is new in                      

                                                              : AIM version 700B and later) 

 outputfile= C:\\temp\\AutoScan.csv       : output data csv file 

A sample file called "External_Control.eba" is included with the zipped AIM files to 
illustrate the communication process.  A compiled version of this sample program can be 
run to get a feel for how the process works. 
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While the AIM is in the external control mode, the other features operate normally. It still 
responds to mouse and keyboard commands. 

 The external control scenario is:  

1. Turn on the AIM power and then start the AIM program. 

2. Change focus to the Master program. 

3. Master program writes control parameters for setting the frequency range. 

4. AIM does a scan with the specified scan limits. 

 6.   Master program waits until C:\Temp\AutoScan.csv (output data file) is created by the 
AIM.  This data file name can be specified in the config file. 

 7.   Master program processes the scan data. 

8. Loop back to step 3. 

This new external control procedure only works with AIM program versions 700 and 

later.  It works with any model of the AIM hardware.
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                           Appendix 11 - Tone and Voice Output 

Setup Menu:  

 

 

TONES: 

While in  the Point Data Tune Mode, a tone related to the SWR, Phase, or Zmag can be 
played through the PC speaker to assist in making adjustments without watching the 
monitor.  When the Point Data window is open, click the button labeled Tone On to start 
the tone.  (Later, click Tone Off to stop the tone.) The magnitude of the parameter that 
corresponds to the highest pitched tone can be changed using the setup routine called 
“Set High Tone Limit” under the Setup tab on the main menu at the top of the screen.  
For example, to make the highest tone correspond to SWR=5,  click Set High Tone Limit 
and enter 5 in the dialog box.  This dialog box also appears when the parameter is first 
enabled.  SWR is converted to a log scale for better resolution at the low end.  The Phase 
and Zmag outputs use linear scales between zero (lowest tone) and the HighToneValue 
(highest tone).  For Phase, the maximum limit is 90 degrees. For Zmag the maximum 
limit is 10K ohms. 

SWR can be sounded out verbally. Use the Setup menu to enable this function.  

The tone or speech output can be played over an extension phone or cell phone 
while making remote adjustments to an antenna.                                       
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Voice Output: 

The SWR value can be sounded out verbally in the Point Data Mode. This feature is 
enabled using the Setup menu -> Voice Output.  This makes it possible to make 
adjustments without looking at the computer monitor.  It’s also possible to send the 
readings to another location using  telephones, cell phones or portable radios. For 
example, the AIM can be located in the lab and you can hear the SWR readings while up 
on a tower. 

The numbers are saved in wav files. Each number is a separate file. The program breaks 
up the swr reading into its separate digits and plays the appropriate wav file for each 
digit.  For example, the number one is a file called: one.wav. The number two is a file 
called: two.wav, etc.  The decimal point is a file called point.wav.  There are 11 separate 
files. These are in a folder whose name is specified in the config file.  The default folder 
is sounds_1 but the name can be anything you like. It has to be a subfolder of the folder 
where the program is located. By changing the folder name, you can have different sets 
of files with different voices and different languages. The content of the wav file does not 
matter at all, only the name is use by the AIM program. The files can be in any language.   

There is an option in the config file to select either one or two digits for the fractional part 
of the reading. Using a single fraction digit will make the repetition rate faster. 

Another config file option controls repeating the same reading. For example, if the swr 
reading is a steady 1.25, you may not want to listen to this over and over.  If the flag is 
zero, the same reading will not be repeated twice in a row. If this flag is some value 
greater than zero, the same reading will be repeated every Nth pass. For example, if the 
flag is equal to 5, the same reading will be repeated after 5 measurements.  Larger or 
smaller numbers can be used too. This way you can tell if the system is still working, 
even when the reading doesn’t change for a long time.  

To get started, I made the wav files myself. This leaves a lot of room for improvement. 
I’m sure some people can improve on the quality of these files and perhaps share them 
with other AIM users.  Since the wav files are completely independent of the AIM 
program, it’s not hard to create a new set in a new folder.  Then change the folder name 
in the config file.  With the menu option: Help -> Edit Config File you can switch 
between voice file sets quickly. If you’re interested in an audio editor, try 
www.wavosaur.com.  



 Antenna Analyzer AIM                                                                                         page 123 

 - 123 - 

                            Appendix 12 - Band Skipping 

When testing a multiband antenna, the scanning process can be speeded up by jumping 
over the spaces between the bands of interest. The bands to be scanned are defined in the 
config file in the same format that is already being used.  On one line, there are three 
numbers: Start_freq, End_freq, Delta_freq.  These are in MHz. The Start and End 
frequencies define a particular band that will be scanned.  These values do not have to 
correspond to a ham band. When scanning a ham band, the entire band does not have to 
be scanned. You can scan just the CW band or the phone band if you want to. 

The calibration procedure, either standard or custom cal, is not affected at all by band 
skipping. The custom cal procedure (if used) is performed at all the frequencies between 
the Start and End points.  The only difference is that raw data points are not read at 
frequencies between the selected bands during a scan. Therefore, the whole freq range 
can be covered in much less time. 

The Start and End frequencies for the scan are set by clicking the Limits button. The 
Step size is specified here and the delta_freq in the config file is not used.  All bands are 
scanned with the same frequency step size, regardless of the value in the config file. 

After setting up the Start and End frequencies, go to the Bands menu and click on Band 

Skip. This flag will alternate between on/off each time you click it. There will be a check 
mark beside Band Skip when it is enabled. 

To compare the performance with and without skipping, first highlight the bands. Then 
click on Scan for a regular scan. Now set Band Skip and click Rescan. The whole scan 
over the bands of interest will be much faster and the data inside the highlighted bands 
will be essentially the same as before, when skipping was off. 

Markers can be very helpful when adjusting multiband antennas or filters.  The SWR for 
each band  can be displayed by analog gauges which make it easier to visualize when the  
optimum points are reached.  See the Marker section of this manual for details. 



 Antenna Analyzer AIM                                                                                         page 124 

 - 124 - 

                    Appendix 13 - AIMuhf Expansion Port 

The AIMuhf has an I/O port with two signal lines. One line is an output driver that can be 
used as a clock or a data output.  The other signal line can be a data output, data input 
or an analog input to the ADC.  Connection to this port, J8, is made with a regular stereo 
plug (3.5mm). 

 

 

This diagram shows the equivalent circuit of the I/O port. The ground is isolated from the 
chassis. Only low currents should flow in this path.  The Ring of the stereo plug is 
connected to the output pin which can be a clock or a data line. The functioning of this 
line can change from one data cycle to the next.  The other data line is connected to the 
tip of the stereo plug. The three functions of this line: Output, Input, Analog Input  can 
change for each data cycle too.  Both of the lines can be used as outputs if desired.  They 
should be buffered in the external accessory with a transistor or a logic gate with a low 
input bias current.  There are resistors in series with these lines to protect them from 
external voltages up to plus or minus 12V. 

R54 is only used for diagnostic tests.  

The Ring signal swings from -5V to +5V.  This is an output only. The current is limited 
by R56. 

The Tip line can be digital in/out, or it can be connected to an analog output signal (such 
as an op amp) in the accessory and then read by the ADC in the AIM. This is a 12 bit 
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ADC with an input range of 0 to 3.3V.  A full-scale input voltage generates an ADC 
reading of 4095. 

Data Format: 

Signal Line Setup Conditions: 

Data 1 - output only.  This defaults to a SYNC output that pulses at the start of a scan. 
Functionally it is similar to the sync output described in Appendix 14.  

Data 2 - output (default), input, ADC input. 
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                    Appendix 14 - Trigger Output 

Newer models of the AIM4170B,C&D,  AIMuhf and PowerAIM have a Trigger output 
(Sync) on the rear panel.  Hardware details are shown below. This pulse can be used to 
trigger a scope or a controller when a measured parameter ( Zmag, Phase, SWR, 

Frequency ) passes through a specified threshold value.  The trigger can also be 
programmed to occur when the scan starts. 

Click the Functions menu at the top of the graph.  

 

Click Trigger Output. 

The Trigger Window pops up to enter the desired trigger conditions: 
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One of the parameters listed on the left side of the window can be used to generate the 
trigger event.  The threshold value is entered in the Trigger Value box.  This value will 
represent ohms if Zmag is selected, degrees if Phase is selected, and MHz if frequency is 
selected. 

The trigger value can be changed any number of times during a test session without 
having to close and reopen the trigger window.  Click the Enter button for a new value.  
The trigger can be enabled or disabled without having to reprogram the trigger data.  This 
makes it easy to perform some adjustments with the trigger turned off, run some scans 
and then enable the trigger again very quickly.  

The slope for triggering can be positive or negative.  The hysteresis for the trigger 
threshold is +/-5 percent of the trigger value.  When the trigger is programmed to occur 
on the positive slope, the trigger is armed when the parameter is 95 percent of the 
threshold.   When the trigger is programmed to occur on the negative slope, the trigger is 
armed when the parameter is 105 percent of the threshold. 

Multiple trigger events can be generated during a single scan.  The scan waveform is 
highlighted with a small dot when the trigger is armed.  When the trigger occurs, a black 
circle indicates the time on the triggering waveform and the trigger data on the right side 
of the Trigger window is updated with the time and the frequency. 

 

This scan shows phase being used to generate the trigger.  Four triggers are generated 
during this scan.  In this case the trigger occurs on the positive slope.  It could also be 
programmed to occur on the negative slope.  The trigger is armed on the negative slope 
of the phase when it drops more than 5 percent below the trigger threshold.  This region 
is shown by highlighting the purple phase trace.  If the parameter does not go more than 
105 percent below the threshold, the trigger will not be armed. 
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The trigger can also be programmed to occur anytime the trigger parameter is greater 
than or less than the trigger threshold.   

If the trigger event is programmed for Frequency, the trigger occurs only once during the 
scan and it is indicated by a  green vertical line on the graph.  The positive/negative slope 

parameter is not used for the frequency trigger event. 

The trigger can be set to occur at the beginning of a scan.  This takes the place of the 
sweep function that was formerly available in the AIM.  The new Trigger Output is much 
more general. 

The sweep procedure is: 
Set the scan limits to the range you want. 
Set Delta Freq to give about 50 to 100 data points (more is ok if you want too).     
Note that any number greater than 20 in the Delta Freq box is considered to be 
the number of measurement points, not the frequency step size in MHz.  For 
example, to get 100 measurement points, just enter 100 in the Delta Freq box.  
The program will convert this to MHz for you. 

Set Averaging to zero. 
Set the Recycle Depth = zero (using the Setup menu.) This provides an 
unlimited number of recycle scans. 
Set the Trigger Output to occur at Scan Start. 
Now in the Recycle mode, you will get a trigger pulse at the sync connector at 
the start of each scan. 
 
The AIM will do a regular scan in the Recycle mode, so you can see a plot of the 
input impedance of a filter during this procedure as well as get a driving signal for 
adjusting the filter.  

The horizontal axis normally represents frequency.  In special cases it can be equivalent 

to time by making the Start and End frequencies very close together and making the Step 
size very small.  The test frequencies are nearly constant and the spacing between 
samples corresponds to time.  If necessary, choose a value of averaging to adjust the 
horizontal time scale factor. In this way the frequency is nearly constant and the 
measured value corresponds to a time varying parameter.  
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The pulse from the AIMuhf model switches between -5V and +5V.  If this goes to a TTL 
or CMOS circuit, the level should be clamped with a series resistor and a zener diode to 
ground.  Instead of a zener, the clamping can be done with two computer diodes like the 
1N4148 or 1N5811.   One diode connects to ground,  the other to the positive supply 
voltage.   Alternatively, a large series resistor can be used and the voltage will be 
clamped by the internal diodes of the integrated circuit that's being driven.  Check the 
data sheet of the device to find the maximum value of clamp current that is allowed.  The 
Sync output is on the Ring terminal of the stereo jack.  

The output signal on the Tip terminal of the stereo jack corresponds to the trigger pulse 
too. It's source impedance is about 40K ohms.  This can be used to drive a  high 
impedance circuit, like the base of a high beta transistor or a CMOS gate.   

 The pulse from the AIM4170B,C or D switches between 0 and +3V.  The series 
impedance is 10K ohms, so the external load should require less than 300 ua of input 
current.  This is a conventional RCA jack (often called a phono jack). 

 

The trigger pulse is normally at a low level. It pulses high when the trigger occurs.  For 
the AIM4170B,C,D and PowerAIM, the width of the pulse, Tpw, is approximately 1.5 
msec times the Averaging value.  The width of the pulse can be changed by using 
different values of averaging.  For the AIMuhf, the width of the pulse is about 1.5 msec.  



 Antenna Analyzer AIM                                                                                         page 130 

 - 130 - 

 Only the leading edge of the pulse should be used for controlling external circuits 
because the width of the pulse may vary. 

Different trigger pulse widths from the AIM4170B, C and D can be used for control 
purposes with an external microprocessor or one-shot logic circuits.  For example, a 
very wide pulse could be used to reset the external hardware to prepare for the next series 
of measurements. This can be generated by setting the averaging value to 64x or 128x. 

The trigger output from the AIM4170 includes a series resistor. This protects the output 
port and it can be used by external circuits for a filter.  The 4.3V zener is part of the 
protection circuit and it does not affect normal operation of the sync output. 
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                   Appendix 15 - Measuring Cable Parameters 

The AIM can be used for measuring several basic parameters of coaxial cables: 

1. Impedance 

2. Velocity Factor 

3. Length 

4. Loss 

The Distance to Fault function will measure these parameters at the same time. 

 Clicking on the Functions menu and selecting Distance to Fault.  

If the Velocity Factor (VF) of the cable is not known, enter a value of zero.  Then enter 
the exact  physical length of the cable that you measured with a ruler or tape measure.  
The program will calculate the VF. 

If the velocity factor of the cable is known, enter it and then the program will determine 
the physical length of the cable and Zo.  The function will display the length of the cable,  
quarter wavelength frequency (90 degree phase shift),  characteristic impedance (Zo), the 
velocity factor and the cable loss at the quarter wave frequency.  

If you need to know the cable loss at other frequencies, enable the Return Loss display 
using the Setup menu and click Plot Parameters -> Return Loss and then do a regular 
scan of the cable over the desired frequency range with the far end of the cable open .  
Move the blue vertical cursor along the scan and the cable loss will be displayed on the 
right side of the graph for each frequency point.   

Note the one-way cable loss is numerically equal to one-half of the return loss.  The 

return loss is the loss that the signal experiences in two passes, down and back along 

the open cable. 
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                     Appendix 16 - Zoom  
 
The trace can be expanded about the frequency point where the vertical 
cursor is located.  This expansion point is moved near the center of the 
graph and a new scan is done with the new start and stop limits.  The 
Zoom Factor is used to calculate the new scan limits.  The default value 
of the zoom factor is 2X but this can be changed to a new value in the 
range of 1.25X to 10X.  Click Zoom Factor on the Setup menu and enter 
the desired value in the dialog box. This value is saved in the init file.   
 
The zoom operation is done by clicking +Zoom on the Setup menu or by 
pressing the "Z" key on the keyboard.  The zoom can be undone by 
clicking -Zoom on the Setup menu or by pressing control-Z.  The current 
Zoom Factor is shown beside the word "Zoom" on the menu, in this 
example it's 2X. 
 
When zooming, the cursor mode can be Normally ON or Normally OFF.  
 
Zooming applies to the frequency axis.  You can change the vertical scale 
factor using the Scales button at the bottom of the screen and replot the 
data with a new vertical scale.  
 
Zooming takes a new scan of the circuit under test.  It is not useful when 

viewing a stored graph off-line.  

 
The zoomed graph is new data and it can be saved to a file just like a 
graph scanned in the usual manner.
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                                     Terms and Conditions 

ORDERING: visit our on-line store at www.arraysolutions.com/pricelist.htm or phone 
us at (972) 203-2008 (9:00-4:00 CST) to order. More information on ordering is shown 
below. 

UPGRADES: Software upgrades are available at  no cost. 

Check the website: w5big.com for the latest version of the program and the latest 
application information.  
 

 Policies and Warranties: 

Products Manufactured By Array Solutions - Limited Warranty 

The warranty on the AIM and related models is two years. We warrant the functioning of 
the product as designed.  If it fails to function as designed, we will repair or replace it free 
of charge as long as you, the original purchaser, own it and it was not damaged from 
lightning, other act of God or other casualty.  We reserve the right to make that 
determination.  We will photograph the evidence of such non-covered damage and will 
be happy to show it to you.  We will listen to any reasonable argument on your behalf to 
alter our opinion and do our best to reach a mutually agreeable solution.  You must pay 
for shipping charges both to and from us. 

 Procedure for Obtaining Warranty Service 

 If you have any doubts as to whether a problem is with our product or somewhere else in 
your system, please call us at our below listed telephone number.  No one else besides us 
is authorized to perform our warranty obligations.  If you are sure the problem is with our 
product, just ship it to our factory address.  Please follow the packaging procedure 
explained below under "ALL REPAIRS."  We will not make a warranty repair unless you 
include a copy of your purchase receipt, so please include it with the product to be 
repaired. 

 This warranty gives you specific legal rights, and you may also have other rights that 
vary from state to state. 

 Products Not Manufactured By Array Solutions - Manufacturer's Warranty Only 

 We do not warrant other products we sell.  They are warranted by the original 
manufacturer.  Please follow the manufacturer's policies and procedures for warranty 
service to insure the best and quickest service. 
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 Provisions Applicable to All Products: 

Very Important, retain all shipping boxes for possible claims made to the shipper for 
damaged product!  Not doing so will affect how your warranty replacement is handled 
since we cannot replace a product that had its damage claim rejected due to the customer 
not retaining the original shipping box. 

 In no case will we be liable for any incidental or consequential damages, which includes, 
but is not limited to, damage to equipment connected or attached to any product we sell.  
Some states do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. 

 Your sole and exclusive remedy upon our failure to meet our warranty obligations to 
repair or replace as described above is refund of the purchase price. 

 ANY CONTROVERSY OR CLAIM ARISING OUT OF OR RELATING TO 
PRODUCTS WE SELL SHALL BE SETTLED BY ARBITRATION IN 
ACCORDANCE WITH THE  ARBITRATION RULES OF THE AMERICAN 
ARBITRATION ASSOCIATION.  

You may obtain warranty information at no charge by calling us at the below telephone 
number or by contacting the manufacturer for products we do not manufacture. 

OTHER THAN AS STATED ABOVE, ARRAY SOLUTIONS DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR 
PURPOSES WHATSOEVER AND ANY IMPLIED WARRANTIES. 

ALL REPAIRS:  When sending in a product for service, please carefully "double" box it 
and ship it insured for your protection.  Please include a note clearly describing the 
problem, how you wish the item returned to you and how you wish to pay for the service 
if it is not covered by our warranty.  Package your item properly.  Array Solutions is not 
responsible for merchandise damaged in shipment.  Our service rate is $50 per hour (2 hr. 
minimum). 

NON-REPAIR RETURNS:  Returned items must be received by us in original, as-
shipped, condition including the original box, manuals, accessories, and copy of sales 
receipt.  Returns must be within 14 days of purchase.  Returned items are subject to a 
15% restocking fee.  Shipping charges are not refundable.  

Phone and FAX:  

Tel: 972 203 2008 

 Fax: 972 203 8811 

 Factory Address: Array Solutions  350 Gloria Rd. Sunnyvale TX 75182 
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 Sales Outside the United States:  Purchase of products by those outside the United States 
of America constitutes purchaser's agreement that all questions concerning the respective 
rights and obligations arising under the terms of purchase are subject to arbitration under 
the provisions of Texas Civil Practice and Remedies Code Section 172.001 et seq. 

On Line: Ordered on line. Our secure, dedicated server is one of the fastest and protected 
with 128-bit encryption. You can be sure of your privacy.  

PAYMENT: We accept Visa, Mastercard,  money orders, cashiers checks and personal 
checks, and bank transfers. Phone order customers please be ready to provide card 
number, expiration, issuing bank, billing and shipping address plus home & work phone 
(e-mail customers please provide this information also). We request this information for 
your protection. Money orders, cashiers checks and personal checks may require 2 weeks 
to clear from un-established customers and/or large purchases.  

MINIMUM ORDER: We have no minimum. Your order is important to us whether it is 
for $5 or $5000.  

SHIPPING of Array Solutions Stocked Products: We ship most orders within 5 business 
days (UPS Next Day and Second Day Air orders are shipped within 24 hours). We ship 
Monday through Friday. Our normal method of shipment is UPS Surface  International 
orders are sent with Air mail parcel post or EMS. We do not ship C.O.D. Array Solutions 
reserves the right at any time after receipt of your order to accept or decline your order 
for any reason. You may request shipment by other means such as FedEx, UPS Next Day 
Air, UPS Second Day Air or Air Freight for export orders. Equipment is packed very 
carefully and sent insured. Please provide us with a full shipping address. UPS cannot 
ship to a Post Office box.  

Shipping of ICE Products is usually shipped to you Factory Direct from ICE. ICE ship 
dates vary extensively due to customer demand and products in stock at their facility. We 
cannot be held liable for the ship date of their products, but we will try to expedite the 
order if we are told by you that you need it by a certain date. Please order these products 
early. 

PRICES: Prices and specifications are subject to change! We are not responsible for 
typographical errors.  

SALES TAX: Array Solutions shall automatically charge and withhold the applicable 
sales tax (8.25%) for orders to be delivered to addresses within the state of Texas. Each 
customer shall be solely responsible for all sales taxes, or other taxes, on orders shipped 
outside Texas.  

FOREIGN ORDERS: Foreign orders must be payable in U.S. dollars. You may use Visa, 
Mastercard, postal money order or bank check drawn on a U.S. bank with transit numbers 
imprinted on bottom of the check or bank transfer to our account. We will supply you our 
banking information upon request. The customer is responsible for shipping on warranty 
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service. We do our best to deliver to you using the more expensive EMS (Express Mail 
Service) parcel post which allows us a tracking number to follow up if there is a problem. 
We have experienced some long deliveries to certain countries like Spain, Portugal, Italy 
and some South American countries. We may insist on using a shipping service such as 
UPS, DHL, FEDEX, or Freight Forwarder for certain countries or large orders due to past 
losses in your country.  

SHIPPING TO Array Solutions: When you ship your equipment for service it is 
important that it is packaged properly. Use the original box and packing material if 
possible. If you do not have the original box, wrap the equipment well with bubble wrap 
then place this in a box with adequate packing material. All equipment should then be 
placed in a second box with packing material to help ensure its safe arrival to us. Please 
be sure to insure your package for its value. Array Solutions will not be responsible for 
equipment that is damaged in shipment to us.  

CUSTOMER INFORMATION: Array Solutions does not sell, rent, lease or trade 
customer information with any other company.  

LIMITATIONS OF LIABILITY: Except as expressly stated herein, Array Solutions. 
makes no representations or warranties, either express or implied, of any kind with 
respect to products sold on the Array Solutions website, including but not limited to, 
merchantability and fitness for a particular purpose. You agree that the sole and exclusive 
maximum liability that Array Solutions has arising from any product sold on the Array 
Solutions web site shall be the price of the product ordered. In no event shall Array 
Solutions, its directors, officers, employees or other representatives be held liable for 
special, indirect, consequential, or punitive damages related to products sold.  

RETURNS: Returned items must be received in the original condition including the 
program CD, power supply, cable, and accessory connectors. Returns must be within 
fourteen days of receipt.  If the original box is not available, suitable boxes can be 
obtained from the post office without charge. Use the original packing materials if 
available or the equivalent. For maximum protection of your equipment, insure the 
package and request a signature when it is received.  Shipping cost is not refundable. We 
will pay the return shipping for warranty repairs. 

WARRANTY SERVICE: Products have a two year limited warranty. This includes parts 
and labor. We will repair or replace the unit at our discretion. 

 

CIRCUITS AND PROCEDURES used by this vector impedance 
measurement system are covered by one or more patents pending. 

 

 


